
PART 5
Edit Page Effects



Chapter 39

Editing, Adding, 
and Copying 
Effects and Filters

DaVinci Resolve 14 added the ability to apply ResolveFX and OFX effects 
as filters in the Edit page. This chapter covers how to browse for and 
apply effects to clips in the Timeline, how to copy them from clip to clip, 
how to remove them, and how to edit them in the Inspector once they’ve 
been added. For more information about the specific ResolveFX that are 
available, see Part 11, “ResolveFX.”
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Using the Effects Library
All effects that you can add to your edit, including filters, transitions, titles, and generators, are 
found in the Effects Library, which is split into two parts. To the left is a Bin list that shows a 
hierarchical list of all of the different transitions, title effects, generators, and filters that are 
available, sorted by category. To the right is a browsing area in which you can see the contents 
of whichever bins are selected.

The Effects Library

Similar to the Media Pool, the Effects Library’s Bin list can be opened or closed using a button 
at the top left, while a dropdown menu in the upper left of the Effects Library pane lets you sort 
the list into different categories.

The Toolbox
All of the video and audio transitions, titles, and generators that ship along with 
DaVinci Resolve:

 � Toolbox: Exposes all transitions, titles, generators, and effects at once.

 – Video Transitions: Contains all of the built-in transitions that are available from 
DaVinci, organized by category. At the bottom of the list, a User category shows 
presets that you’ve saved. You can drag any video transition to any edit point in the 
Timeline that has overlapping clip handles to add it to your edit; you have the option 
to drag the transition so that it ends on, is centered on, or starts on the edit point. 
For more information, see Chapter 35, “Using Transitions.”

 – Audio Transitions: Contains audio transitions for creating crossfades.

 – Titles: Titles can be edited into the Timeline like any other clip. Once edited into the 
Timeline, you can edit the title text and position directly in the Timeline Viewer, or 
you can access its controls in the Inspector for further customization.
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 – Generators: Generators can also be edited into the Timeline like any other clip. 
Selecting a generator and opening the Inspector lets you access its controls for 
further customization. You can also choose a standard duration for generators to 
appear within the Editing panel of the User Preferences.

 – Effects: Effects are essentially placeholders in the Timeline that allow for more 
specialized compositing in Fusion, or that let you modify the underlying tracks with 
an adjustment clip.

OpenFX
DaVinci Resolve supports the use of third-party OpenFX filters, transitions, and generators in 
the Edit page. Once you install these effects on your workstation, they appear in this section of 
the Effects Library, organized by type and group depending on the metadata within each effect.

 � OpenFX: Exposes all ResolveFX and third-party OpenFX installed on 
your workstation at once.

 – Filters: Contains the ResolveFX filters that ship with DaVinci Resolve, as well as any 
third-party OFX plug-ins you’ve installed on your workstation. Filters can be dragged 
onto video clips to apply an effect to that clip. Once applied, filters can be edited 
and customized by opening the OpenFX panel of the Inspector.

 – Generators: Contains any third-party OFX generators you have installed on your 
workstation. Can be edited into the Timeline just like the native generators that ship 
with DaVinci Resolve, but they also expose an OpenFX panel next to the Transition 
panel in the Inspector, where you can customize settings that are unique to that 
transition.

 – Transitions: Contains any third-party OFX transitions you have installed on your 
workstation. OFX transitions can be used similarly to any other transition, but they 
also expose an OpenFX panel next to the Transition panel in the Inspector, where 
you can customize settings that are unique to that transition.

AudioFX
On all platforms, DaVinci Resolve supports a set of built-in FairlightFX, a native audio plug-in 
format that makes various audio tools and effects available on macOS, Windows, and Linux. On 
macOS and Windows, DaVinci Resolve supports the use of third-party VST audio plug-ins, 
which includes most of the professional third-party tools and effects used in the audio 
postproduction industry. On macOS, DaVinci Resolve supports Audio Unit (AU) audio plug-ins. 
Once you install these effects on your workstation, they appear in this panel of the Effects 
Library. Audio plug-ins let you apply effects to audio clips or entire tracks’ worth of audio, to add 
creative qualities such as echo or reverb, or to take care of mastering issues using noise 
reduction, compression, or EQ.
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Effects Library Favorites
You can click on the far right of any transition, title, or generator flag that effect with a star as a 
favorite effect. When you do so, the favorited effects appear in a separate Favorites area at the 
bottom of the Effects Library Bin list.

Stars indicate a flagged favorite effect; all favorites are currently filtered

Seeing Effects in the Timeline
When you apply any kind of an effect to a clip in the Timeline, be it an adjustment in the 
Inspector, a speed effect, a plug-in you’ve applied, etc., clips with that effect appear a darker 
shade of whatever color they are to show you there’s an effect applied. Removing all effects 
from a clip (for example, using the Remove Attributes command) returns that clip to its original 
color. This makes it easy to see, at a glance, which clips have effects, and which clips don’t.

A clip with effects that’s shaded darker between two other regularly-shaded clips without effects
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Using the Inspector
Once you’ve added effects to a timeline, the Edit page Inspector is where you can edit their 
parameters. Closed by default, the Inspector is the central area for editing all of the settings 
relating to filters, compositing, sizing, titling, transitions, generators, and effects of all kinds. 
Many of the instructions in this section require the use of the Inspector, which can be opened or 
closed by clicking the Inspector button at the far right of the Edit page toolbar, or by double-
clicking a transition or generator in the Timeline. 

The Inspector displays different parameters depending on what you’ve selected in 
the Timeline; (left) parameters of a clip, (right) parameters of a title

There are three ways that the parameters of clips in the Timeline can be displayed in 
the Inspector:

 � If no clips are selected in the Timeline, then the clip in the highest auto-select-enabled 
track that intersects the playhead will have its parameters shown in the Inspector.

 � The Inspector always shows the parameters of one or more selected items in the 
Timeline, which will override the clip in the highest track that intersects the playhead, if 
necessary. Changing the selection changes which parameters are displayed, and the 
parameters you edit in the Inspector only alter the currently selected clip. If multiple 
clips are selected, the Inspector displays “Multiple Clips” and allows you to adjust the 
parameters of all selected clips at the same time.
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 � Choosing Timeline > Selection Follows Playhead sets DaVinci Resolve to always select 
whichever clip intersects the playhead in the Timeline. The result is that the Inspector 
always displays the parameters of the clip at the playhead, with the added bonus that 
the clip at the playhead is also selected for other editorial functions. If there are multiple 
superimposed clips intersecting the playhead all at once, the topmost video clip with 
an enabled Auto Select control will be selected, thus exposing its parameters in the 
Inspector, and all other clips will be ignored.

Opening Effects Using Selection Follows Playhead
Ordinarily, it’s possible for the Inspector to show the parameters of a selected clip even when 
the playhead is over another clip. You can change this behavior by choosing 
Timeline > Selection Follows Playhead, which sets DaVinci Resolve to always select whichever 
clip intersects the playhead in the Timeline. The result is that the Inspector always displays the 
parameters of the clip at the playhead, without you needing to do anything other than moving 
the playhead back and forth in the Timeline. 

If there are multiple superimposed clips intersecting the playhead all at once, the topmost video 
clip with an enabled Auto Select control will be selected, thus exposing its parameters in the 
Inspector, and all other clips will be ignored.

Inspector Controls
Different clips in the Timeline expose different controls. For example, ordinary video clips 
expose Video and Audio panels, while text generators expose Title and Video panels. 
Whichever panels are exposed, parameters within each panel are organized into groups, with a 
title bar providing the name of that group, along with other controls that let you control all 
parameters within that group at the same time. 

Closed and open Inspector group controls

These controls include:

 � Enable button: A toggle control to the left of the parameter group’s name lets you 
disable and re-enable every parameter within that group at once. Orange means that 
track’s enabled. Gray is disabled.

 � Parameter group title bar: Double-clicking the title bar of any group of parameters 
collapses or opens them. Even more exciting than that, Option-double-clicking the title 
bar of one parameter group collapses or opens all parameter groups at once.

 � Keyframe and Next/Previous Keyframe buttons: This button lets you add or remove 
keyframes at the position of the playhead to or from every single parameter within the 
group. When the button is highlighted orange, a keyframe is at the current position of 
the playhead. When it’s dark gray, there is no keyframe. Left and right arrow buttons let 
you jump the playhead from keyframe to keyframe for further adjustment.

 � Reset button: Lets you reset all parameters within that group to their default settings.
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Adding Filters to Video Clips
DaVinci Resolve supports both built-in ResolveFX and third-party OFX plug-ins to create 
various effects. These effects can be applied both to clips in the Edit page, and to nodes in the 
Color page. This section shows how to apply, edit, and remove these filters in the Edit page. For 
more information about using video effects in the Color page, see Chapter 132, “Using OpenFX 
and ResolveFX.” 

For a detailed explanation of each of the ResolveFX plug-ins that accompany DaVinci Resolve, 
see Part 11, “ResolveFX.”

Methods of applying video filters in the Edit page:
 � To apply a video filter to a clip: Drag any filter from the OpenFX category of the 

Effects Library onto the clip in the Timeline you want to apply it to.

 � To apply a video filter to multiple clips: Select all of the clips you want to apply a 
filter to in the Timeline, and then drag any filter from the OpenFX category of the 
Effects Library onto any of the selected clips. This is undoable.

Applying a video filter to a single clip in the Timeline

To edit a clip’s video filters:
Select that clip and open the Inspector. All video filters applied to that clip appear 
within the OpenFX panel.

ResolveFX controls appear in the OpenFX 
panel of the Inspector
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Some video filters have custom onscreen controls that can be modified in the Viewer. 
These can be exposed in the Edit page using the OFX mode of the Viewer.

Turning on the onscreen controls for ResolveFX in the Edit page Timeline Viewer

Once enabled, the OFX onscreen controls appear in the Viewer.

Modifying onscreen controls for ResolveFX in the Edit page Timeline Viewer

Many audio filters expose custom controls that appear in a floating window.

To expose a filter’s custom controls: 
Open the parameters if they’re not open already by double-clicking that filter’s title bar. 
A button should appear at the top of the parameters for filters that have custom UI. 
Clicking this button opens a floating window with all the custom controls. When you’re 
finished adjusting the custom controls, close the window.

The FairlightFX Noise Reduction custom UI interface
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Methods of working with video filters in the Inspector:
 � To rearrange the order of multiple video filters applied to a clip: Click the move up or 

move down buttons in any filter’s title bar, to the left of each filter’s Trash Can button.

 � To disable or re-enable a filter: Click the toggle control at the far left of each 
filter’s title bar. Orange means that track’s enabled. Gray is disabled.

 � To remove a filter: Click the Trash Can button.

 � To reset a filter: Click the Reset button at the far right of the filter’s title bar.

 � To open or collapse a filter’s parameters: Double-click the title bar.

 � To open or collapse the parameters of all filters: Option-click the title bar.

Once applied to a clip, video filters can also be keyframed or automated just like any other 
Inspector setting, to create dynamic effects that change over time.

Adjusting Multiple Clips 
at the Same Time
There’s an easy way to make adjustments to the Inspector parameters of multiple clips at the 
same time, without needing to use Paste Attributes (described later in this chapter). All you 
need to do is simultaneously select every clip you want to alter, and then modify the parameter 
in the Inspector that you want to change. As a result, every selected clip will be adjusted by the 
same amount. This works for compositing effects, transforms, text parameters, filters, and audio 
settings, just about anything that can be simultaneously exposed in the Inspector for multiple 
selected clips.

When you select multiple clips, the Inspector will display “Multiple Clips” as the title. If each of 
the selected clips have different values in the parameter you’re adjusting, that parameter will 
have two dashes in the value field. There are two ways you can make adjustments to 
multiple clips:

 � If you want to make a relative adjustment to all selected clips while keeping their 
original offsets from one another, then drag the virtual slider in the parameter field 
which will display a + or – before however many units your adjustment is.

 � However, if you want to set all selected clips to the same value, you can double-click in 
the number field, type the value, and press Return.

Making a relative adjustment of plus 4.9 in 
the Rotation Angle of all selected clips
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Adjustment Clips
You can also apply all sorts of effects to multiple clips in the Timeline using Adjustment clips, 
available from the Effects bin of the Toolbox in the Effects Library. When an Adjustment Clip is 
superimposed above one or more clips in the Timeline, any filters or other effects that are 
applied to the Adjustment clip are also applied to all clips underneath it. 

Adjustment clips can be used to apply the following types of effects:

 � ResolveFX and OpenFX plug-ins

 � Inspector parameters including Composite, Transform, Cropping, and Dynamic Zoom

 � Fusion page effects

 � Color page grading and sizing

Adjustment clips are a fast and easily revised way to apply one or more effects and grades to a 
range of clips. Adjustment Clips can be named using the Inspector. To store an Adjustment clip, 
simply drag it from the Timeline to the Media Pool. You can then manage the Adjustment clip 
just like any other media type. 

An Adjustment clip applying a Prism Blur 
ResolveFX’s vignette to two other clips
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Paste Attributes
You can copy and paste video and audio attributes, as well as color corrections, from one clip 
to multiple clips using the Paste Attributes command. This is a fast way to apply video and audio 
adjustments and effects from one clip to many others in the Timeline.

To copy attributes:
1 Select a clip with attributes you want to apply to other clips, and press Command-C.

2 Select one or more other clips to paste to.

3 Choose Edit > Paste Attributes (Option-V), or right-click one of the selected clips and 
choose Paste Attributes from the contextual menu.

4 When the Paste Attributes window appears, click the checkboxes of each of the 
attributes you want to paste, and click Apply when you’re done.

The Paste Attributes window

The Paste Attributes window shows you the clip you’re copying from and the clip(s) you’re 
pasting to at the top, and provides checkboxes you can use to select which attributes you’d like 
to paste. 

Keyframe Options for Pasting Keyframed Attributes
A pop-up menu below lets you choose how you’d like to apply any keyframes that are part of 
the attributes being pasted; the options are Maintain Timing or Stretch to Fit.

Option to Ripple the Timeline for Pasting Speed Effects
When using Paste Attributes to copy speed effects from one clip to another, the Ripple 
Sequence checkbox lets you choose whether or not the pasted speed effect will ripple 
the Timeline.
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Remove Attributes
You can also eliminate specific attributes from one or more clips, using a window that’s the 
opposite of the Paste Attributes window.

The Remove Attributes window

To remove attributes:
1 Select one or more other clips that have effects you want to remove.

2 Choose Edit > Remove Attributes, or right-click one of the selected clips and choose 
Remove Attributes from the contextual menu.

3 When the Remove Attributes window appears, the checkboxes of effects that can be 
removed are enabled, so turn on attributes you want to remove.

4 (Optional) If one of the attributes you’re removing is a retime effect, use the Ripple 
Sequence checkbox to choose whether or not the Timeline will ripple as a result.

5 Click Apply when you’re done.
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Chapter 40

Titles, 
Generators, 
and Stills

Using the Edit page, you can add titles, effects generators, and stills to 
your timelines. You can also save customized titles, generators, and stills 
back to the Media Pool for future use.
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Adding Titles
There’s a collection of titles and generators in the Toolbox that you can use to create leader 
when outputting to tape, add slates, create subtitles, and otherwise fulfill any textual needs your 
program has.

The available titles in the toolbox

Titles and generators can be edited much like any other clip. Furthermore, when selected, both 
titles and generators expose the same Composite, Transform, and Cropping parameter groups 
as any other clip; these parameters can be used to composite titles and fly them around in 
order to create different text effects.

Methods of adding and editing generators and titles:
 � To drag and drop a generator directly into the Timeline: If you simply drag and 

drop titles or generators into the Timeline, the default duration of the resulting clip is 
5 seconds. This duration can be customized in the Edit panel of the User Preferences.

 � To edit a generator using the edit overlays of the Timeline Viewer: Click the 
destination control of the clip you want to edit a generator into, then set Timeline In and 
Out points to define the duration of the resulting edit, and drag the generator you want 
to edit onto the edit overlay of the Timeline Viewer that corresponds to the type of edit 
you want to perform.

 � To reposition the text of a title in the Timeline Viewer: Select the title generator you 
want to edit in the Timeline, then click the visible text in the Timeline Viewer so that 
its bounding box is selected; in this state you can reposition, scale, and rotate the text 
item. As you reposition text, it will snap to key regions of the frame such as the vertical 
and horizontal center of the Viewer; hold the Option key down to suspend snapping if 
you want to freely position the text.

 � To edit the text of a title in the Timeline Viewer: Select the title generator you want to 
edit in the Timeline, then double-click the visible text in the Timeline Viewer to insert 
a text editing cursor. At this point, you can select, delete, or add any text you want by 
typing directly in the Timeline Viewer.

 � To edit the parameters of a generator or title: Open the Inspector, and select the 
generator or title you want to edit to open it into the Inspector.
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Using Safe Area Overlays
If you’re working on a broadcast program and you want to adhere to guidelines for title safe and 
broadcast safe, you can choose to display overlays that indicate where these regions are in the 
Edit page. 

To do so, choose View > Safe Area > On. 

The available safe area overlays

If necessary, there are a number of ways you can customize this overlay by choosing one of the 
other options in the View > Safe Area submenu to toggle specific parts of the safe area overlay 
on and off. These options include:

 � Extents: An outline showing the exact outer edge of the frame. Especially useful when 
the safe markers are set to an aspect ratio other than that currently used by the Viewer.

 � Action: An outline showing the outer 90% action safe area of the frame.

 � Title: An outline showing the outer 80% title safe area of the frame.

 � Center: A crosshairs showing the center of the frame.

 � Aspect: Enables use of the View > Select Aspect Ratio submenu to change the aspect 
ratio of the safe area markers. You can choose among the following aspect ratios: 1.33 
(a.k.a. 4:3), 1.66, 1.77 (a.k.a. 16:9), 1.85, and 2.35.

Custom Action and Title Safe Areas
The Editing panel of the User Preferences has a new “Use custom safe area overlays” checkbox 
that, when turned on, displays Action Area and Title Area fields that let you set a custom 
percentage for each. The default values are 93% for Action Area and 90% for Title Area.
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Types of Title Generators
When opened into the Inspector, titles expose a set of text parameters that allow you to style 
the contents of that clip’s Text field within the Inspector. Each of the titles supports rich text, so 
you can individually style words, lines, or paragraphs of text using the available parameters 
including Color, Font, and Size. Other attributes such as Alignment, Anchor, Position, and 
Shadow affect the entire title.

The following titles are available:

 � L Lower 3rd: (supports rich text) Automatically positions two lines of text at the bottom 
left corner of title safe, each with a different set of rich text and Position/Zoom/Rotation 
controls for independent sizing and animating.

 � M Lower 3rd: (supports rich text) Automatically positions two lines of text at the bottom 
middle of title safe, each with a different set of rich text and Position/Zoom/Rotation 
controls for independent sizing and animating.

 � R Lower 3rd: (supports rich text) Automatically positions two lines of text at the bottom 
right corner of title safe, each with a different set of rich text and Position/Zoom/
Rotation controls for independent sizing and animating.

 � Scroll: (supports rich text) Automatically automates a scrolling title sequence from 
the bottom to the top of the screen. The duration of the generator clip in the Timeline 
determines the speed of the scroll. Identical parameters as the Simple title.

 � Text: (supports rich text) Useful for creating titles consisting of a word, line, or 
paragraph of text. A single body of text shares one set of rich text controls that let you 
style selected parts of the title text differently.

 � Text+: (does not support rich text) An advanced title generator based on the title 
generation tools on the Fusion page. This generator has significantly more options for 
styling, rendering, and animating than the simple title generator above, but all title text 
shares a single style.

 � Fusion Titles: A variety of pre-built title templates assembled in Fusion. 
DaVinci Resolve comes with a library of pre-assembled Fusion titles, but you can also 
create your own to appear in this category of the Effects browser.

DaVinci Resolve Title Generators
The original title generators that shipped with DaVinci Resolve all share similar controls, and 
they all share the ability to support rich text styling.

Editing Titles Within the Timeline Viewer
Once you add a title generator to the Timeline, the original title generators that shipped with 
DaVinci Resolve have onscreen controls that let you edit text and transform and position blocks 
of text directly within the Timeline Viewer.

Positioning and Transforming Text
So long as the Timeline playhead is positioned over a text generator that’s on top of one or 
more background clips, clicking on the text in the Timeline Viewer reveals onscreen transform 
controls that correspond to the Position, Zoom, and Rotation parameters in the Inspector.
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Drag the text to position it in the Viewer

While dragging text to reposition it, snapping occurs at the X and Y center of the frame, as well 
as around the outer third of the frame. Holding the Shift key down while dragging a text object 
constrains movement to just the X or Y axes.

Editing Text
Double-clicking on text in the Timeline Viewer puts that text into an editable state, wherein you 
can insert a text cursor or select characters to edit the text as you would in any text editor.

Double-click on the text to edit it in the Viewer

Title Generator Panels
The parameters of text generators are divided into two panels: the Text panel and the 
Video panel. 

 � The Text panel contains all of the text editing, styling, and sizing controls used to edit 
the contents and look of a title in your project, including the Rich Text, Drop Shadow, 
Stroke, and Background parameters.

 � The Video panel contains the same Composite, Transform, and Cropping parameters 
that all other clips in DaVinci Resolve have. These parameters are intended for 
compositing and animating a title.

Shared Title Generator Parameters
With the exception of the Text+ generator, all other title generators in DaVinci Resolve are 
capable of rich text styling. This means you can select any portion of a generator’s text and 
style it differently. For example, you could have three lines of text within a single generator and 
style each line individually to create a particular design.
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A single generator with three lines of differently styled text

Each title generator shares the same parameters in the Text panel of the Inspector for editing 
and styling text:

 � Rich Text: A control group consisting of a text entry field and parameters that can be 
used to style different parts of the text independently.

 – Text: A text entry field for editing the title being generated. If no characters are 
selected, the styling controls affect the entire block of text. If you select a specific 
set of characters, the styling controls only affect the selection. Text in this field can 
also be edited directly in the Timeline Viewer.

 – Font family: A pop-up for choosing one of the font families installed on your 
workstation.

 – Font face: A pop-up for choosing which face of the font family currently 
selected to use.

 – Color: Opens the standard color picker for choosing a font color.

 – Size: Slider for choosing the text size.

 – Tracking: Slider that sets the spacing between characters.

 – Line spacing: Slider for setting the spacing between the selected line of text and the 
next one below.

 – Font style: Buttons to apply underline, overhead line, strikethrough, superscript, 
and subscript styling.

 – Font case: A pop-up for forcing the text selection to be Mixed Case (the default), 
All Caps, All Lowercase, Small Caps, or Title Caps.

 – Alignment: Buttons to select the method of alignment: left, centered, right, 
or justified.

 – Anchor: Buttons for selecting how text is anchored to the current position, 
both horizontally (top, centered, bottom) and vertically (right, centered, left).

 – Position: X and Y parameters determining the bottom left-hand corner (the default 
Anchor settings) of the rich text block being generated. Corresponds to the act of 
dragging a selected text box in the Timeline Viewer.

 – Zoom: X and Y parameters determining the scale of the text. A link button lets 
you keep the X and Y parameters locked together. Corresponds to the act of 
resizing a selected text box in the Timeline Viewer from either the corners (to resize 
proportionally), or the top/bottom/sides (to stretch or squeeze the text).

 – Rotation Angle: A slider for rotating the orientation of the text. Corresponds to the 
act of rotating a selected text box in the Timeline Viewer using the rotation handle..
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 � Drop Shadow: A group of controls that lets you apply a customizable drop shadow to 
every character of text being generated.

 – Color: Opens the standard color picker for choosing a drop shadow color.

 – Offset: X and Y parameters determining how offset the drop shadow is from the 
original text.

 – Blur: A slider for blurring the drop shadow.

 – Opacity: A slider determining how transparent the drop shadow is.

 � Stroke: Lets you add an outline to every character of text being generated.

 – Color: Opens the standard color picker for choosing the stroke color.

 – Size: A slider lets you choose the thickness of the stroke, in pixels.

 � Background: This group of controls provides an extremely flexible rectangle or 
rounded rectangle shape that you can use to add a background, bar, outline, 
or other intersecting shape to use when designing a title.

 – Color: Opens the standard color picker for choosing the interior color of the 
background shape.

 – Outline color: Opens the standard color picker for choosing outline color of the 
background shape.

 – Outline width: A slider lets you choose the thickness of the background shape 
outline, in pixels.

 – Width: A slider lets you choose how wide to make the background shape.

 – Height: A slider lets you choose how tall to make the background shape.

 – Corner radius: A slider lets you choose the roundness of the rectangle edges.

 – Center: X and Y parameters you can use to offset the background shape from 
the text being generated.

 – Opacity: A slider lets you set the transparency of the background shape.

Title Generator Video Parameters
Additionally, each generator has Composite, Transform, and Cropping parameters in the Video 
panel of the Inspector that let you composite, resize, and animate titles against other clips in the 
Timeline for motion graphics effects. These parameters are the same as those available for 
every clip, as described later in this chapter.

The Text+ Title Generator
A new kind of title generator, named Text+, is available in the Titles category of the 
Effects Library’s toolbox. This is the exceptionally fully-featured 2D text generator from Fusion, 
available for editing and customizing right in the Edit page. It’s capable of most of what the 
Text generator can do, with the exception of rich text editing and a lack of on-screen controls in 
the Timeline Viewer. However, it also has many more styling and animation controls than the 
Text generator has.

TIP: At the time of this writing, the Text generator is still very useful for quickly creating 
text pages with multiple styles, whereas the Text+ generator excels at creating text for 
animated motion graphics.
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The new Text+ title generator, along with new Fusion titles below

You can use the Text+ generator the same way you use any generator in the Edit page. Simply 
edit it into a video track of the Timeline, select it, and open the Inspector to edit and keyframe 
its numerous properties to create whatever kind of title you need. 

In addition to having many more styling options, the origin of the Text+ generator in a 
compositing tool means that it offers many more panels worth of keyframable parameters, 
along with advanced animation controls built-in. These include keyframable Write On/Write Off 
controls, layout and animation using shapes (options include point, frame, circle, and path), 
character, word, and line transforms and animation, advanced shading, and full 
interlacing support.

Four panels of the Text+ title generator, including Text, Layout, Transform, and Shading
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Better yet, with the playhead parked on your new Text+ “Fusion Title,” you can open the Fusion 
page and access its parameters there too, if you want to start building upon this single 
generator to create a multi-layered motion graphics extravaganza.

Opening the Text+ node in the Fusion page 
reveals it as an actual Fusion page operation

For more information about the extensive capabilities of the Text+ generator, see Chapter 89, 
“Generator Nodes.”

Fusion Titles and Fusion Templates
The abundance of other Fusion titles in the Effects Library are custom-built text compositions 
with built-in animation that expose custom controls in the Inspector.

A Fusion title creating an animated lower third, with controls open in the Inspector

In actuality, these text generators are Fusion templates, which are Fusion compositions that 
have been turned into macros and come installed with DaVinci Resolve to be used from within 
the Edit page like any other generator. 

It’s possible to make all kinds of Fusion title compositions in the Fusion page, and save them for 
use in the Edit page by creating a macro and placing it within the /Library/Application Support/
Blackmagic Design/DaVinci Resolve/Fusion/Templates/Edit/Titles directory, but this is a topic 
for another day.

There’s one other benefit to Text+ generators and that is they can be graded like any other clip, 
without needing to create a compound clip first.
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Saving Titles in the Media Pool 
for Future Use
If you’ve created a title in a style that you want to later reuse, for example, a particularly 
formatted lower third that will be the basis for every lower-third in your program, you can drag 
any title from the Timeline to the Media Pool, and it will be saved as a separate clip. Title clips 
in the Media Pool are shown with a thumbnail showing a preview of the text they contain. 
If you’ve keyframed any animated text or video adjustments, those keyframes are also saved 
with this clip.

A text generator saved as a clip in the Media Pool

Once saved in the Media Pool, text generators can be opened in the Source Viewer and edited 
just like any other clip.

Using Generators
Generators, with the exception of Solid Color, lack editable parameters other than the 
Composite, Transform, Cropping, and Dynamic Zoom parameters that are standard for every 
clip. Additionally, generators have a Display Name field in the Inspector that lets you give a 
particular clip a custom name that appears in the Timeline.

The following generators are available:

 � 10 Step: A grayscale ramp segmented into 10 steps from black to white.

 � 100mV Steps: A grayscale ramp segmented into segments of exactly 100mV each.

 � EBU Color Bar: A 1.77:1 aspect ratio set of color bars for PAL-using countries.

 � Four Color Gradient: A gradient that blends four different colors at each corner of the 
frame. You can adjust the Center X and Center Y parameters to move the center at 
which all four colors blend together, and you can change the four colors that appear at 
each corner using corresponding color parameters.

 � Grey Scale: A simple grayscale ramp from black to white.

 � SMPTE Color Bar: An updated 1.77:1 aspect ratio set of color bars for 
NTSC-using countries.

 � Solid Color: A simple fullscreen color generator. A Color parameter lets you choose 
what color this generator outputs.

 � Window: A simple white-on-black shape generator, defaulting to a white rectangle 
against a black background.

 � YCbCr Ramp: A gradient designed to test the Y’CbCr signal.

Chapter – 40 Titles, Generators, and Stills 815



Fusion Generators
The Fusion Generators section of the Generators panel contains Fusion effects that have been 
made into reusable generators. By default, a single generator, Noise Gradient, appears as an 
example of how these work. Fusion Generators work like any other generator. Once edited into 
the Timeline, they act like any other clip, and when selected, they expose customizable 
parameters in the Inspector that let you tailor their effect to meet your needs.

However, Fusion Generators are highly customizable. Simply opening the Fusion page while 
the playhead intersects a Fusion Generator on the topmost track of the Timeline exposes all of 
the Fusion nodes that create that generator’s effect, enabling you to rebuild the effect to do 
whatever you need. Furthermore, if you know how to create effects in Fusion, you can create 
your own generators by making Fusion Macros and saving them to the Effects Library, so they 
appear in the Fusion Generators section of the Effects Library. For more information on how to 
do this, see Chapter 57, “Node Groups, Macros, and Fusion Templates.”

Using Stills
You can import still images into the Media Pool, and edit them into the Timeline as clips with 
custom durations. By default, imported stills are 10 seconds long, but you can extend a still 
image’s Out point to a maximum of 17 hours and 40 minutes in length, which ought to cover just 
about any project you’re planning on working on, so long as you’re not Andy Warhol. 
DaVinci Resolve is correspondingly capable of importing still image clips referenced by XML or 
AAF project files, so long as they’re in a supported format. 

DaVinci Resolve supports the use of stills in the following formats:

File Format Alpha Channel Support

.tif Yes

.png Yes

.jpg No

.dpx No

.exr Yes

.dng No

.psd No

.tga Yes

.heif No

Once edited into the Timeline, still image clips have the same Composite, Transform, Cropping, 
Retime, and Scaling attributes as any other clip.
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Photoshop File Support
Photoshop (.psd) files appear as a single clip displaying only the bitmapped layers within the 
Edit page and Color page of DaVinci Resolve. Photoshop text layers and layer effects are not 
supported at the time of this writing.

Fusion Page PSD Support

The Fusion page has support for multi-layered Photoshop files. You can use the Fusion 
> Import > .PSD command to import Photoshop files such that each individual layer 
appears as a separate MediaIn node connected to a cascading series of Merge nodes, 
ready for you to work on.
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Chapter 41

Compositing and 
Transforms in the 
Timeline

The Edit page is also home to many of the compositing and transform 
effects found in DaVinci Resolve. Many of these kinds of effects can be 
imported into DaVinci Resolve, including composite modes, opacity 
settings, and clips using alpha channels. Once in DaVinci Resolve, you can 
make changes to these effects in the Edit page. Alternately, you can also 
use DaVinci Resolve’s controls to create effects from scratch.
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Composite Modes and 
Transparency Effects
Composite modes are effects that use various mathematical operations to combine one 
superimposed clip with another, relying on standard image processing math for each color 
channel whereby black pixels have a value of 0, white pixels have a value of 1, and descending 
levels of gray are represented by decimal point values (for instance, 0.5 represents 50% gray). 
When using composite modes to blend two clips together on the Timeline, the three color 
channels of each pair of pixels are combined using that particular composite mode’s math. 
The results can create transparency effects, increase image exposure, and combine multiple 
images in many creative and useful ways.

Two source clips combined with the Subtract composite mode

When using composite modes, it’s easy to push parts of the resulting image above the 
maximum or below the minimum values for brightness. However, this image data is not clipped, 
even through such areas of the picture may appear flat white or black. Out-of-range data as a 
result of a composite mode effect is preserved, and may be retrieved by later image processing 
operations in the Color page.

When you import XML project files, DaVinci Resolve imports whatever composite modes were 
used by clips in the original sequence. If necessary, you can then change a clip’s composite 
mode to one that will work better with whatever grade you’re creating. Of course, you can also 
add composite modes to clips that didn’t originally have them, adding new effects of your own. 
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All composite modes interact with the Opacity slider (found below the Composite Mode pop-up 
menu in the Inspector) to make a clip more or less transparent in addition to compositing 
already being done.

Composite modes can be used on clips that are superimposed over other clips in the Timeline. 
However, these composite modes are also available for use within a grade on the Color page 
using the Layer Mixer node, within which you can combine differently graded versions of an 
image in creative ways. For example, the Add and Overlay composite modes can be useful for 
creating glow effects, while Subtract and Difference can create more surreal effects.

Working with composite modes in the Edit page is simple.

To set or change a composite mode for any clip:
Select a clip in the Timeline, then open the Inspector and choose one of the options from the 
Composite Mode pop-up menu.

Composite mode and Opacity controls in the Timeline

To turn a clip’s composite mode off:
Select a clip in the Timeline, then open the Inspector and choose Normal from the 
Composite Mode pop-up menu.

More About Composite Modes
There are ten composite modes to choose from. For clarity, simple image math is used to help 
explain the available Composite Mode effects.

Normal
No image compositing is done. The topmost image on the Timeline or the bottom input of the 
Layer Mixer node occupies the entire frame.

Add
Each pair of pixels in both superimposed layers is added together. Layer order does not matter. 
This can result in a dramatic brightening of light areas of both images with areas of the picture 
that are blown out to maximum white, and this effect is often used by adding the brighter part of 
an image to itself to create hot glow effects. Image data going above 1.0 is preserved and may 
be retrieved by later color correction operations. On the other hand, black areas of either image 
do not alter the combined image at all (0 + n = n).

Color
Recombines two layers using HSL image components by combining the Luma of the bottom 
layer with the Hue and Saturation of the top layer.

Color Burn
Inverts the bottom layer, which is divided by the top layer, and the end result is itself inverted.
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Color Dodge
The bottom layer pixels are divided by the top layer, which has been inverted.

Darken
Each pair of pixels in each color channel is compared, and the darker of the two is the output. 
Layer order does not matter. Darken is useful when you want the darker features of both layers 
to take precedence, but the output for any given pixel may be a color that doesn’t actually exist 
for that pixel in either of the source layers.

Darker Color
For each pair of pixels, all three color channels from the bottom layer are added together, and 
all three color channels from the top layer are added together. These results are compared, and 
the darker pixel of the two layers is the output. Layer order does not matter. Darker Color is 
useful when you want the darker features of both layers to take precedence. Unlike the Darken 
composite mode, the result will always be a specific color from either the bottom or top layers.

Difference
The absolute value is taken of the top layer minus the bottom layer, and returned as the result, 
which is always a positive number. Layer order does not matter. This Blend mode is often used 
to compare two differently processed versions of the same image to see if there are any 
alterations, and how large they are.

Divide
Divides the bottom layer by the top layer. Any color divided by itself = 1.0, or white, while any 
color divided by white (1.0) = itself.

Exclusion
Similar to the Difference composite mode, but results in lower contrast.

Hard Mix
The R, G, and B channel values of the bottom layer are added to the R, G, and B channel values 
of the top layer. Layer order does not matter. Can result in extreme effects.

Hardlight
Hardlight is the opposite of Overlay. All bottom layer pixels above 50% are Multiplied, while all 
bottom layer pixels 50% and below are Screened.

Hue
Recombines two layers using HSL image components, by combining the Luma and Saturation 
of the bottom layer, with the Hue of the top layer.

Lighten
Each pair of pixels in each color channel is compared, and the lighter of the two is the output. 
Layer order does not matter. Lighten is useful when you want the lightest features of both layers 
to take precedence, but the output for any given pixel may be a color that doesn’t actually exist 
for that pixel in either of the source layers.
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Lighter Color
For each pair of pixels, all three color channels from the bottom layer are added together, and 
all three color channels from the top layer are added together. These results are compared, and 
the lighter pixel of the two layers is the output. Layer order does not matter. Lighten Color is 
useful when you want the lighter features of both layers to take precedence. Unlike the Lighten 
composite mode, the result will always be a specific color from either the bottom or top layers.

Linear Burn
Each pair of pixels is summed, and 1 is subtracted from the total. Layer order does not matter. 
Regions of white in one layer let the other layer show through, while colors and darker tones 
from both layers interact to tint or darken the resulting image.

Linear Dodge
Each pair of pixels is summed. This composite mode is identical to Add.

Linear Light
All regions where the bottom layer is above 50% are Linear Dodged so as to lighten these parts 
of the final result, while all regions where the bottom layer is below 50% are Linear Burned so 
as to darken these parts of the final result. This composite mode intensifies image contrast in 
the final result.

Luminosity
Recombines two layers using HSL image components by combining the Hue and Saturation of 
the bottom layer with the Luma of the top layer.

Multiply
Each pair of pixels is multiplied together. Layer order does not matter. This generally has the 
effect of emphasizing the darkest parts of both images in the resulting output; in particular 
black areas of either image are preserved (0 * n = 0) while white areas of either image have no 
effect on the output image (1 * n = n). Multiply is good for compositing darker elements in a field 
of white into an image, and can be used to emphasize the darkest parts of a noise, grain, or 
damage layer you’re blending with an image.

Overlay
Overlay combines useful aspects of both the Screen and Multiply composite modes, based on 
the pixel values of the bottom-most image on the Timeline; all bottom layer pixels above 50% 
are Screened, while all bottom layer pixels 50% and below are Multiplied. Overlay is an 
excellent composite mode for combining a layer of noise, grain, or damage imagery with 
another clip, as it combines both images in visually useful ways throughout the tonal range of 
shadows through highlights.

Pin Light
In regions where bottom layer pixels are below 50% gray, lighter pixels in the top layer are 
replaced by darker pixels from the bottom layer, and darker pixels in the top layer replace 
lighter pixels in the bottom layer, so that the darker half of the final image combines darker 
pixels from both layers. In regions where bottom layer pixels are above 50% gray, darker pixels 
in the top layer are replaced by lighter pixels from the bottom layer, and lighter pixels in the top 
layer replace darker pixels from the bottom layer, so that the brighter half of the final image 
combines lighter pixels from both layers.
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Saturation
Recombines two layers using HSL image components, by combining the Luma and Hue of the 
bottom layer, with the Saturation of the top layer.

Screen
The pixel values of each layer are inverted, then multiplied, and the result is itself inverted. 
Layer order does not matter. Screen is the inverse of Multiply, as it preserves the lightest parts 
of both images, and is useful when compositing lighter elements in a field of black into an 
image, and can be used to emphasize the lightest parts of a noise, grain, or damage layer 
you’re blending with an image.

Softlight
A less intense method of applying the Hardlight composite mode that results in a more even 
blend between the two layers.

Subtract
Within each pair of pixels, those of the bottom layer are subtracted from those of the top. 
This can result in dark areas of the image that hit flat black, but image data going below 0 is 
preserved and may be retrieved by later color correction operations.

Vivid Light
All regions where the bottom layer is above 50% are Color Dodged so as to lighten these parts 
of the final result, while all regions where the bottom layer is below 50% are Color Burned so as 
to darken these parts of the final result. This composite mode vastly intensifies both image 
contrast and saturation in the final result, for an extreme effect.

Unknown
When importing XML or AAF project files with composite modes that aren’t available in 
DaVinci Resolve, the Composite Mode pop-up menu is set to Unknown; practically, this is the 
same as Normal.

Opacity
Each clip has an Opacity parameter, available in the Inspector, that lets you make it more 
transparent, in a range from 0 (totally transparent) to 100 (totally opaque). When set to a value 
less than 100, the selected clip is mixed with whatever clip is underneath it on the Timeline, 
according to the composite mode that’s currently used. If no clip appears underneath the 
Timeline, then the clip is mixed with black.

By keyframing this parameter, you can create more complicated fade to black effects or 
cross dissolves. Keyframing is covered in more detail in Chapter 44, “Keyframing Effects 
in the Edit Page.”

To change a clip’s opacity:
Open the Inspector, then select the clip you want to adjust, and set the Opacity slider 
to create the desired amount of transparency.
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Video Fader Handles
If you want to dissolve a clip to or from another clip, or to or from black, the traditional way to do 
so has been to use one of the transitions in the Effects Library. However, you can also use fader 
handles that appear at the beginning and end a clip when you position the pointer right over it. 
Fader handles are a fast, ubiquitous method of creating a fade to or from black. However, they 
also make it easy to fade to or from other clips that are underneath one that’s superimposed, as 
seen in the following screenshot.

Dragging a video fader handle on a clip in track V2

To use a fader handle, move the pointer over the clip you want to adjust, and when small white 
fader handles appear at the upper left and upper right of the video of the clip, drag them to the 
left or right for the duration you want the fade effect to last.

Fade In and Out to Playhead Commands
A pair of commands in the Trim menu let you use the playhead position over a clip to “Fade In to 
Playhead” or “Fade Out to Playhead.” This can be done for a single clip or for multiple 
superimposed clips. 

These commands work for both audio and video items, in both the Edit and Fairlight pages.

Alpha Channel Support
If a superimposed video or still image clip in the Timeline has an embedded alpha channel, that 
alpha channel automatically creates transparency within that clip, compositing it against 
whatever is in the track underneath. There’s no need for you to do anything for this to work. 

Superimposing a clip with an alpha channel above 
automatically composites that clip against the clip beneath it
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However, if you need to disable or alter the interpretation of an alpha channel for any clip, for 
example if a clip is being interpreted as having an alpha channel of the wrong type, you can 
right-click that clip, choose Clip Attributes from the contextual menu, and use the Alpha Mode 
pop-up menu of the Clip Attributes Video panel to correct the problem.

NOTE:  If you’ve imported clips with alpha channels, those alpha channels can be 
rendered back out for Round Trip workflows if you set Render to Individual Clips in the 
Deliver page, choose a Format and Codec combination that supports alpha channel 
output, and turn on the Export Alpha checkbox in the Video panel of the Render 
Settings list.

Keying, External Mattes, and 
Window Compositing
It’s also possible to use the Qualifier, Power Window controls, and External Matte clips in the 
Color page to create compositing effects by connecting a key that you create to the optional 
Alpha output that can be added to the Node Editor. In this way, you can pull a simple 
greenscreen key using a qualifier, do rotoscoping or matte work using a Power Window, or use 
an external matte to composite two or more clips together, and see these effects on the 
Edit page.

For more information on the use of the Alpha output to do node-based compositing, see 
Chapter 126, “Combining Keys and Using Mattes.”

Transform and Cropping
DaVinci Resolve is a resolution-independent application. This means that, whatever the 
resolution of your source media, it can be output at whatever other resolution you like. This also 
means that you can freely mix clips of any resolution, fitting 4K, HD, and SD clips into the same 
timeline, and scaling each to fit the project resolution as necessary.

Your project’s resolution can be changed at any time, allowing you to work at one resolution, 
and then output at another resolution. This also makes it easy to output multiple versions of a 
program at different resolutions, for example, outputting both HD and 4K sized versions of the 
same program.

DaVinci Resolve has a powerful toolset for making geometric transforms, using advanced 
algorithms for optical-quality sizing operations. Within the Edit page, each clip has a set of 
transform parameters, principally for use in storing sizing data imported from AAF or XML when 
you turn on the “Use sizing information” checkbox. This has the advantage of keeping these 
imported Edit Transform settings separate from the Input Sizing parameters found on the Color 
page, which are typically used by the colorist to make pan and scan adjustments of 
various kinds.

Of course, you can also use these controls to create your own adjustments while working in the 
Timeline, zooming into clips, repositioning them to improve the composition, and so on. 
While there is some overlap between these parameters and those in the sizing palette of the 
Color page, they’re both separate sets of parameters, so you can keep each set of 
adjustments separate. 
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When the time comes to output your program, the final resolution of each clip is calculated 
taking into account the original resolution of the source media, the timeline resolution, image 
scaling settings, Edit page transforms, and Color page transforms, so that the final resolution 
correctly uses the cleanest geometric transformation based on the maximum resolution 
available to each source clip.

Transform
The Edit page transform group includes the following parameters, which are also editable in the 
Edit Sizing mode of the Sizing palette in the Color page:

 � Zoom X and Y: Allows you to blow the image up or shrink it down. The X and Y 
parameters can be linked to lock the aspect ratio of the image, or released to stretch or 
squeeze the image in one direction only.

 � Position X and Y: Moves the image within the frame, allowing pan and scan 
adjustments to be made. X moves the image left or right, and Y moves the image 
up or down.

 � Rotation Angle: Rotates the image around the anchor point.

 � Anchor Point X and Y: Defines the coordinate on that clip about which all transforms 
are centered. 

 � Pitch: Rotates the image toward or away from the camera along an axis running through 
the center of the image, from left to right. Positive values push the top of the image 
away and bring the bottom of the image forward. Negative values bring the top of the 
image forward and push the bottom of the image away. Higher values stretch the image 
more extremely.

 � Yaw: Rotates the image toward or away from the camera along an axis running through 
the center of the image from top to bottom. Positive values bring the left of the image 
forward and push the right of the image away. Negative values push the left of the 
image away and push the right of the image forward. Higher values stretch the image 
more extremely.

 � Flip Image: Two buttons let you flip the image in different dimensions.

 � Flip Horizontal control: Reverses the image along the X axis, left to right.

 � Flip Vertical control: Reverses the clip along the Y axis, turning it upside down.

Cropping
The Edit page has an additional set of cropping parameters:

 � Crop Left, Right, Top, and Bottom: Lets you cut off, in pixels, the four sides of the image. 
Cropping a clip creates transparency, so that whatever is underneath shows through.

 � Softness: Lets you blur the edges of a crop. Setting this to a negative value softens the 
edges inside of the crop box, while setting this to a positive value softens the edges 
outside of the crop box.

Dynamic Zoom
The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan 
effects to zoom into or out of a clip. Also, if you import a project from Final Cut Pro X with clips 
that use the Ken Burns effect, then those clip’s effects will populate the Dynamic Zoom 
parameters in DaVinci Resolve. Turning the Dynamic Zoom group on activates two controls in 
the Inspector that work hand-in-hand with the Dynamic Zoom onscreen adjustment controls 
you can expose in the Timeline Viewer (described below):
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 � Dynamic Zoom Ease: Lets you choose how the motion created by these controls 
accelerates. You can choose from Linear, Ease In, Ease Out, and Ease In and Out.

 � Swap: This button reverses the start and end transforms that create the dynamic 
zoom effect.

Stabilization
Image Stabilization is available for clips right in the Edit page. These controls let you smooth out 
or even steady unwanted camera motion within a clip. The analysis is performed in such a way 
as to preserve the motion of individual subjects within the frame, as well as the overall direction 
of desirable camera motion, while correcting for unsteadiness.

These are the same stabilizer controls found in the Color page’s Tracker palette (minus the 
tracker graph), and the resulting stabilization analysis is mirrored on the Color page, where you 
can see the data visualized on the graph, if necessary.

Stabilization controls found in the Edit page Inspector for each clip

A pop-up menu provides three different options that determine how the selected clip is 
analyzed and transformed during stabilization. You must choose an option first, before clicking 
the Stabilize button above, because the option you choose changes how the image analysis is 
performed. If you choose another option, you must click the Stabilize button again to 
reanalyze the clip.

 � Perspective: Enables perspective, pan, tilt, zoom, and rotation analysis and 
stabilization.

 � Similarity: Enables pan, tilt, zoom, and rotation analysis and stabilization, for instances 
where perspective analysis results in unwanted motion artifacts.

 � Translation: Enables pan and tilt analysis and stabilization only, for instances where 
only X and Y stabilization gives you acceptable results.

The other controls let you customize how aggressively the selected clip is stabilized.

 � Stabilization Toggle: The toggle control for the Stabilization controls lets you turn 
stabilization off and on to be able to compare the stabilized and unstabilized image.

 � Camera Lock: Turning on this checkbox disables Cropping Ratio and Smooth, and 
enables the stabilizer to focus on eliminating all camera motion from the shot in an 
effort to create a locked shot.

 � Zoom: When this checkbox is turned on, the image is resized by a large enough 
percentage to eliminate the blanking (black edges) that is the result of warping and 
transforming the image to eliminate unwanted camera motion. The lower a value 
Cropping Ratio is set to, the more DaVinci Resolve will need to zoom into an image 
to eliminate these blanked edges. If you turn this off, the image is not zoomed at all, 
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and whatever blanking intrudes into the image is output along with the image, on 
the assumption that you’ll have dedicated compositing artists deal with eliminating 
this blanking by filling in the missing image data in a more sophisticated manner. 
You may also leave this checkbox turned off if you’re planning on animating the Input 
Sizing Zoom parameter to dynamically zoom into and out of a shot being stabilized to 
eliminate blanking only where it occurs, using only as much zooming as is necessary for 
each region of the shot.

 � Cropping Ratio: This value limits how hard the stabilizer tries to stabilize, by dictating 
how much blanking or zooming you’re willing to accept in exchange for eliminating 
unwanted motion. A value of 1.0 results in no stabilization being applied. Progressively 
lower values enable more aggressive stabilization. Changing this value requires you to 
click the Stabilize button again to reanalyze the clip.

 � Smooth: Lets you apply mathematical smoothing to the analyzed data used to stabilize 
the clip, allowing camera motion in the shot while eliminating unwanted jittering. Lower 
values perform less smoothing, allowing more of the character of the original camera 
motion to show through, while higher values smooth the shot more aggressively. 
Changing this value requires you to click the Stabilize button again to reanalyze the clip.

 � Strength: This value is a multiplier that lets you choose how tightly you want to use 
the stabilization track to eliminate motion from a shot using the current analysis. With 
a value of 1, stabilization is maximized. Since some clips might look more natural with 
looser stabilization, choosing a number lower than 1 lets a percentage of the original 
camera motion show through. Zero (0) disables stabilization altogether. As an additional 
tip, you can invert the stabilization by choosing –1 when pasting a stabilization analysis 
from another clip to perform a match move based on the overall motion of the scene, 
and you can use a negative value either lower than 0 or higher than –1 to under or 
overcompensate when inverting the stabilization, simulating the effects of parallax 
where foreground and background planes move together but at different speeds.

Retime and Scaling
The Retime and Scaling group has four parameters that affect retiming quality and clip scale:

 � Retime Process: Lets you choose a default method of processing clips in mixed frame 
rate timelines and those with speed effects (fast forward or slow motion) applied to 
them, on a clip-by-clip basis. The default setting is “Project Settings,” so all speed 
effected clips are treated the same way. There are three options: Nearest, Frame Blend, 
and Optical Flow, which are explained in more detail in the Speed Effect Processing 
section of Chapter 42, “Speed Effects.”

 � Motion estimation mode: When using Optical Flow to process speed change effects or 
clips with a different frame rate than that of the Timeline, the Motion Estimation pop-up 
lets you choose the best-looking rendering option for a particular clip. Each method 
has different artifacts, and the highest quality option isn’t always the best choice for a 
particular clip. The default setting is “Project Settings,” so all speed effected clips are 
treated the same way. There are several options. The “Standard Faster” and “Standard 
Better” settings are the same options that have been available in previous versions 
of DaVinci Resolve. They’re more processor-efficient and yield good quality that are 
suitable for most situations. However, “Enhanced Faster” and “Enhanced Better” 
should yield superior results in nearly every case where the standard options exhibit 
artifacts, at the expense of being more computationally intensive, and thus slower 
on most systems. The Speed Warp setting is available for even higher-quality slow 
motion effects using the DaVinci Neural Engine. Your results with this setting will vary 
according to the content of the clip, but in ideal circumstances this will yield higher 
visual quality with fewer artifacts than even the Enhanced Better setting. 
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 � Scaling: Lets you choose how clips that don’t match the current project resolution 
are handled on a clip-by-clip basis. The default setting is “Project Settings,” so that all 
mismatched clips use the same method of being automatically resized. However, you 
can also choose an individual method of automatic scaling for any clip. The options 
are Crop, Fit, Fill, and Stretch; for more information see the 2D Transforms section of 
Chapter 133, “Sizing and Image Stabilization.”

 � Resize Filter: For clips that are being resized in any way, this setting lets you choose 
the filter method used to interpolate image pixels when resizing clips. Different settings 
work better for different kinds of resizing. There are four options:

 – Sharper: Usually provides the best quality in projects using clips that must be scaled 
up to fill a larger frame size, or scaled down to HD resolutions.

 – Smoother: May provide higher quality for projects using clips that must be scaled 
down to fit an SD resolution frame size.

 – Bicubic: While the Sharper and Smoother options are slightly higher quality, Bicubic 
is still an exceptionally good resizing filter and is less processor intensive than either 
of those options.

 – Bilinear: A lower quality setting that is less processor intensive. Useful for previewing 
your work on a low-performance computer before rendering, when you can switch to 
one of the higher quality options.

Lens Correction
The Lens Correction group (only available in Resolve Studio) has two controls that let you 
correct for lens distortion in the image, or add lens distortion of your own.

 � Analyze: Automatically analyzes the frame in the Timeline at the position of the 
playhead for edges that are being distorted by wide angle lens. Clicking the Analyze 
button moves the Distortion slider to provide an automatic correction. If you’re 
analyzing a particularly challenging clip, a progress bar will appear to let you know how 
long this will take.

 � Distortion: Dragging this slider to the right lets you manually apply a warp to the image 
that lets you straighten the bent areas of the picture that can be caused by wide angle 
lenses. If you clicked the Analyze button and the result was an overcorrection, then 
dragging this slider to the left lets you back off of the automatic adjustment until the 
image looks correct.

Onscreen Controls for Transform, 
Crop, and Dynamic Zoom
You also have the option of transforming, cropping, or adding dynamic zoom effects to clips 
using the Transform/Crop/Dynamic Zoom button at the bottom left of the Timeline Viewer. 
These on-screen controls can also be selected by choosing an option from the View > Viewer 
Overlay submenu; these commands are not mapped to keyboard shortcuts by default, but you 
can make a manual mapping if there’s a mode you find yourself using regularly. The currently 
selected overlay can be toggled on and off by pressing Shift-` (Tilde), or by choosing View > 
Viewer Overlay > Toggle On/Off.
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Transform controls in the Timeline Viewer

Object Snapping in the Viewer
While dragging objects or dynamic zoom outlines to reposition them, snapping occurs at the 
X and Y center of the frame, as well as around the outer third of the frame. Holding the Shift key 
down while dragging a text object constrains movement to just the X or Y axis.

Using Onscreen Controls
For many, the onscreen controls provide a more intuitive experience for manipulating your clips.

To transform a clip using graphical controls in the Timeline Viewer:
1 Click the Transform/Crop button at the bottom left of the Timeline Viewer to turn it 

on; white is enabled, gray is disabled. When enabled, if no clips are selected in the 
Timeline, then the clip in the highest auto-select-enabled track that intersects the 
playhead will display onscreen transform controls. If a clip is selected, that specific clip 
can be transformed.

2 Do one of the following:

a Choose the Transform mode from the pop-up menu, if necessary, to change modes. 
The appropriate onscreen controls appear to let you manipulate the clip with the 
mouse. When in Transform mode, you can drag anywhere within the clip’s bounding 
box to adjust pan and tilt, drag any diagonal corner to proportionally resize, drag any 
side to squeeze or stretch just width or height, or drag the center handle to rotate.

Onscreen controls for transforming in the Timeline Viewer

b Choose the Cropping mode from the pop-up menu. In this mode, each side has a 
handle for cropping.
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Onscreen controls for cropping in the Timeline Viewer

c Choose the Dynamic Zoom mode from the pop-up menu. In this mode, the green 
box shows the starting size and position of the animated transform, while the red 
box shows the ending size and position of the animated transform. Drag anywhere 
within either bounding box to adjust pan and tilt for either the start or the end of the 
animated effect, and drag any of the corners to adjust the size. A motion path 
appears to show the motion that’s being created. Adjusting the Dynamic Zoom 
controls automatically enables dynamic zoom in the Inspector.

Onscreen controls for transforming and cropping in the Timeline Viewer

3 If necessary, choose a smaller viewing percentage from the Timeline Viewer scale pop-
up to better see the onscreen controls if you’re rescaling the image, or use the scroll 
control of your mouse, trackpad, or tablet to zoom out of the image.

4 When you’re finished, turn the Transform/Crop/Dynamic Zoom button off.
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Chapter 42

Speed Effects

You can import both linear and nonlinear speed changes from other 
applications, or you can create these effects from scratch in order to 
speed up or slow down clips in your programs. DaVinci Resolve has a 
comprehensive set of controls for creating these kinds of effects using 
dedicated Retime controls, curves, and specific edit types. Once created, 
DaVinci Resolve also provides different ways of processing these effects 
to create the smoothest possible playback.
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Speed Effects and Retiming
Speed effects describe any effect that speeds up, slows down, or otherwise changes the 
playback speed of clips in the Timeline. There are four basic ways you can create speed effects 
in DaVinci Resolve.

 � Importing speed effects: DaVinci Resolve is capable of reading linear speed effects 
from imported EDL, AAF, and XML projects, and nonlinear speed effects from XML and 
AAF project files. When speed effects are present, DaVinci Resolve plays clips at the 
specified speed. You can also create speed effects of your own using controls in the 
Edit page. There are two methods of adjusting clip speed: using the Change Speed 
dialog, and using the Retiming effect in the Timeline.

 � Creating speed effects using Fit to Fill edits: You can also change a clip’s speed in 
the Timeline by editing it using the Fit to Fill command, which retimes the clip to fit into 
an arbitrary duration in the Timeline of your choosing. For more information on using 
Fit to Fill, see Chapter 30, “Three- and Four-Point Editing.”

 � Creating freeze frames: You can use the freeze frame command to turn an entire clip 
into a freeze frame of a frame intersecting the playhead.

 � Creating simple linear speed effects: You can create simple fast or slow-motion 
speed effects by using the Change Clip Speed command, or by using the left and right 
handles of the Retime controls in the Timeline. Both of these methods are described in 
this section.

 � Creating variable speed effects: You can create much more complex variable speed 
effects, where the same clip speeds up or slows down multiple times by different 
amounts, using either the Retime controls, or one of the two different speed curves that 
are available. These methods are also covered later in this section.

Speed Effects and Audio

Any of the methods of creating linear speed effects that are available in 
DaVinci Resolve, including the Change Clip Speed command, the Retime controls, and 
the Fit to Fill edit, will retime a clip’s audio, without pitch correction on Linux and 
Windows, and with pitch correction on Mac OS X (Yosemite and above), along with its 
video. However, audio that accompanies variable speed effects will be muted.

Creating Freeze Frames
There are a few ways you can create a freeze frame, but the fastest is to position the playhead 
over the frame you want to be the freeze frame, and choose Clip > Freeze Frame, or press 
Shift-R. The entire clip becomes a freeze frame of the frame you parked the playhead over. 

If you want to disable the freeze frame effect, you can select the clip and use the Remove 
Attributes dialog to remove the speed effect, or you can simply open the Change Clip Speed 
dialog and turn the Freeze Frame checkbox off.
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Creating Simple Linear Speed Effects
If all you need to do is to make a clip play in slow motion, speed it up, reverse the clip, or create 
a freeze frame, you can apply a simple speed effect using either the browser or the Change 
Speed dialog.

To change a clip’s speed, do one of the following:
 � Select a clip, choose Clip > Change Clip Speed, and use the controls of the Edit Speed 

Change dialog.

 � Right-click a clip in the Timeline, choose Change Clip Speed, and use the controls of 
the Edit Speed Change dialog.

Change Clip Speed operations have the following options:
 � Change Clip Speed parameters: Changes the speed of the selected clip by whatever 

percentage, frame rate, or duration you like.

 � Ripple Sequence checkbox: If you want the speed change you’re about to make 
to ripple the Timeline, pushing or pulling all clips following the current one to 
accommodate the clip’s new size, then turn on the checkbox.

Speed effect parameters shown in the Speed dialog

 � Reverse Speed checkbox: Clicking this box sets the current speed to a negative value, 
reversing the motion of the clip.

 � Freeze Frame checkbox: Changes the entire clip to a freeze frame of whichever frame 
is at the current position of the playhead.

 � Pitch Correction checkbox: Checking this box will perform pitch correction on the 
audio attached to the clip so that while the audio duration is changed to match 
the picture speed, it will still sound natural. Be aware that pitch correction on large 
speed adjustments may not sound as good as pitch corrections made to small 
speed adjustments.

 � Maintain Timing/Stretch to fit radio buttons: Choosing Maintain Timing leaves any 
keyframes within the clip locked at their original position, while choosing Stretch 
Keyframes results in all Composite, Transform, and Cropping keyframes being 
compressed or stretched by the same percentage as the clip during a speed change.
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Clip Retiming Controls
Another method of altering clip speed in the Timeline is to apply the Retime effect. This method 
of clip retiming provides a convenient control overlay that you can use to adjust clip speed 
directly in the Timeline, and it also provides the controls that are needed for creating variable-
speed effects.

To expose the Retime controls on a clip:
 � Select a clip, and choose Clip > Retime Controls (Command-R).

 � Right-click a clip and choose Retime Clip from the contextual menu.

The Retime controls appear over that clip in the Timeline. They consist of a Retime control track 
running along the top of the clip with arrows that indicate the speed and direction of playback 
(the default blue right-facing arrows indicate normal 100% playback) and a Clip Speed pop-up 
menu at the bottom center of the clip, which also shows the current speed of the clip.

The Speed effect controls in the Timeline

Retiming an Entire Clip
The simplest way of using the Retiming effect is to change the playback speed of the entire clip, 
in the process rippling the rest of the Timeline to the right of the retimed clip as you increase its 
duration by stretching or compressing its duration.

To retime a clip by dragging:
Move the pointer to the left or right edge of the Speed Change name bar on top of the 
clip, and when it turns into a Retime cursor, drag either side to stretch or squeeze the 
clip to retime it.

To retime a clip by specific amounts:
1 Select a clip and press Command-R.

2 Click the pop-up next to the speed percentage text at the bottom of the clip.

3 Do one of the following:

 – Choose a new playback speed from the Change Speed submenu.

 – Choose reverse segment to make the clip play in reverse. Reverse speed is shown 
in the Retime control track as arrows facing left, instead of right.
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To return a clip to its original speed:
Click the pop-up next to the speed percentage text at the bottom of the clip, and choose 
Reset to 100%.

Rippling or Overwriting the Timeline When Using Retime
Whether or not clips to the right in the Timeline will ripple to accommodate the change in 
duration resulting in speed changes you make with the Retime controls depends on whether 
you’re using the Selection tool/mode (in which case the Timeline won’t ripple), or the Trim tool/
mode (in which case the Timeline will).

Reading Clip Speed Arrows
When you retime a clip, the Clip Speed pop-up menu displays the current speed of the entire 
clip. Additionally, the arrows in the Retime control track show you the speed and direction of 
playback. When clip speed is slowed down below 100%, the Retime control track shows yellow 
playback triangles that are spaced farther apart. When clip speed is sped up above 100%, the 
Retime control track shows blue triangles that are bunched closer together. At 100% normal 
speed, the Retime control track shows blue, evenly spaced triangles, while left-facing blue 
arrows indicates reverse playback.

Three clips set to different speeds. From left to right, 100% speed, 
slow motion, and fast forward are indicated by the yellow arrows.

Creating Variable Speed Effects Using the Retime Controls
You can also use the Retime controls to insert freeze frames within the middle of a clip, and 
create other custom variable speed effects using speed points. Additional variable speed 
options include rewind and speed ramp effects, which automatically place speed points to 
create preset effects.

To create a freeze frame at a particular moment in time:
1 With the Retime controls exposed, move the playhead to the frame you want to freeze, 

within that clip. Ideally, this will be for an effect where you want a character in motion to 
suddenly stop at a particular frame.

2 Open the Clip Speed pop-up menu (the pop-up next to the speed percentage text at 
the bottom of the clip), and choose Freeze Frame. Two new speed points are added to 
the clip, defining a range within which the clip is frozen at that frame. This can be seen 
by the vertical red bars in the Retime control track. Past the second speed point, the 
clip resumes playback from the next frame forward.
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Speed effect controls set to insert a momentary freeze frame within the clip

3 Drag the second speed point forward or back to define the duration of the freeze 
frame. The result is that the clip plays normally up until the first speed point, then 
freezes on that frame until the second speed point, at which playback resumes.

To create variable-speed effects:
1 With the Retime controls exposed, move the playhead to the frame at which you want 

to change the speed of the clip, and choose Add Speed Point from the Clip Speed 
pop-up menu.

2 Move the playhead forward to the next frame at which you want the clip speed to 
change again, and add another speed point. It takes a minimum of two speed points to 
create a speed effect.

3 To alter the speed of the clip segment appearing between these two speed points, do 
one of the following:

 – Using the pointer, drag the top handle of the second speed point to the right to slow 
down clip playback, or to the left to speed up clip playback within just that segment. 
Doing this either shortens or lengthens the clip, and either overwrites or ripples 
neighboring clips depending on whether you’re using the Selection or Trim modes.

 – Also using the pointer, you can drag the bottom handle of any speed point to 
widen the range of the clip that plays at that particular speed. Doing this reallocates 
frames from before and after the speed segment being adjusted to keep all speed 
segments playing at the same speed, and this also shortens or lengthens the clip, 
but by a different amount.

 – Using the Clip Speed pop-up menu, choose a new speed for that segment from the 
Change Speed pop-up menu. You can also set any segment to play in reverse by 
choosing Reverse Segment.

4 To clear a speed point and eliminate that particular clip’s speed segment from the 
effect, choose Clear Speed Point from any Clip Speed pop-up menu to eliminate 
whichever speed point appears to its left.

When you create variable-speed effects, the arrows in the Retime control track can help you 
keep track of what you’re doing, and each segment’s speed pop-up shows you the actual 
numeric speed. The change in speed from each speed segment to the next is automatically 
eased, for a smooth transition from one speed to another.
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Speed controls set to ramp among three different playback speeds; arrow spacing shows the timing

There are two additional sets of commands for creating preset speed effects that use multiple 
speed points.

To add a rewind effect:
With a clip’s Retime controls exposed, open any Clip Speed pop-up menu and choose a preset 
percentage from the Rewind submenu. This results in two additional speed points being added 
after the rightmost speed point in the current segment, which creates the effect of the current 
segment playing in fast reverse for the chosen percentage, and then playing a second time 
from the beginning.

Speed effect controls before and after creating a “rewind” effect

To add a speed ramp:
With a clip’s Retime controls exposed, open any Clip Speed pop-up menu and choose one of 
the two options from the Speed Ramp submenu to replace the current speed effect with a 
series of five speed segments that start at 10% and increase progressively to 30%, 50%, 70%, 
and then 90%. Once created, you can drag the speed points to customize this effect to create 
whatever durations you require.
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Speed effect controls set to create a gradual ramp from 0 to 100 percent playback speed

Closing Retime Controls
When you’re finished creating your Retime effect, you can close the Retime controls so that clip 
assumes a normal appearance again. Closing the Retime controls has no effect on the timing of 
the clip, it just ensures you cannot accidentally modify the speed of the clip with the mouse.

To close the Retime controls in the Timeline:
 � Click the X button at the upper left-hand corner of the Retime control box.

 � Select the retimed clip, and either choose Clip > Retime Controls, or press Command-R.

When a retimed clip has its Retime controls hidden, a Retime badge appears to the left of that 
clip’s name in the Timeline. You can reopen the Retime controls whenever you need to make 
further changes.

The Speed Effect badge that 
shows a clip is being retimed

To reopen the Retime controls in the Timeline:
Select the retimed clip, and either choose Clip > Retime Controls, or press Command-R.

Once you’ve retimed a clip using the Retime effect, you can use that clip’s Retime Process 
parameter in the Inspector to define how that clip’s retiming is processed, using the low quality 
Nearest option, using Frame Blending, or using Optical Flow. 

Using Retime Curves
You can also optionally use curves to retime clips, either in conjunction with the Retime 
controls, or by themselves. For example, you can use the simpler retiming controls first to create 
the overall speed effect you need, and then use either of the available Retime Curves to create 
further refinements by adjusting Bezier curve handles to adjust the transition of one speed to 
another, or you can expose either of the Retime Curves first and use it to create your speed 
effect from scratch by adding and adjusting control points and curve segments. 
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The Retime Curves let you adjust the transition from one speed to another using handles

No matter how you like to work, the control points of each of the speed curves have a 1:1 
correspondence to the speed points that are exposed in the Retime controls, and curve 
segment modifications are mirrored by speed point adjustments in the Retime controls if you 
have both exposed at the same time. This means that, when creating complex variable retiming 
effects, it’s easy to drag whichever control most easily adjusts the quality of speed you require.

In addition, there are two kinds of Retime curves you can use for maximum flexibility. Which is 
best depends on what you’re more comfortable with, and on which will handle the type of 
motion you want to create more easily:

 � The Retime Frame curve exposes a diagonal line that represents a time graph. This 
is a type of curve found in many other post-production applications, in which the 
vertical axis represents each frame of that clip’s source media, and the horizontal axis 
represents each frame of playback in the Timeline. With the default diagonal graph, 
there is a one-to-one correspondence between each frame of source media and each 
frame of timeline playback; this represents 100% speed. However, adding control points 
lets you alter how source frames are mapped to the Timeline. For any two control 
points on the Retime Frame curve, so long as the control point at the left is lower than 
the control point at the right of a curve segment, there will be forward motion, with 
longer shallow curve segments creating slower motion, and steeper shorter curve 
segments creating faster motion in the clip. 

A diagonal Retime Frame curve with two segments: a long shallow segment to the left that 
creates slow motion, and a short steep segment to the right that creates fast motion
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 � If a curve segment has a left control point that’s higher than the right control point, then 
the motion will be reversed and that segment will play backward.

A Retime Frame curve with an inverted curve that creates reverse motion

 � The Retime Speed curve (seen below) exposes a flat line that represents 100% speed. 
Adding pairs of control points and dragging each segment to raise or lower it alters 
speed; you must drag the segments, not the control points themselves. Raising a curve 
segment shortens that segment and speeds up that portion of the clip, while lowering a 
curve segment lengthens that segment and slows down that portion of the clip. As you 
adjust each curve segment, a tooltip shows you the exact speed percentage that 
segment represents. You should note that it’s impossible to create reverse motion using 
the Retime Position curve; you need to use either the Retime controls or the Retime 
Speed curve described above.

A Retime Speed curve with two segments: a shorter one that 
creates fast motion, and a longer segment that creates slow motion

Methods of working with speed curves:
 � To expose speed curves for a clip in the Timeline: Right-click a clip in the Timeline, 

and choose Retime Curve. The Curve Editor is exposed for that clip, and you can edit it 
as you would any other curve, adding moving, and deleting control points.
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 � To switch between editing Retime Speed and Retime Frame curves: Use the Curve 
pop-up at the upper left-hand corner of the Curve Editor to check or uncheck the 
curves you want to be visible. Clicking on a curve within the editor makes that curve the 
currently edited one.

 � To close a speed curve: Clicking the Curve button at the right-hand side of the clip’s 
title bar in the Timeline toggles the curve open and closed.

As far as adding, removing, and smoothing control points on speed curves and adjusting 
curve segments, they work identically to any other curve in the Timeline. For more information, 
see “Keyframing in the Timeline and Curve Editor” in Chapter 44, “Keyframing Effects in the 
Edit Page.”

Speed Effect Processing
Once you’ve retimed a clip, you have the additional ability to change how the retimed clip is 
processed in order to improve its visual playback quality, especially in the case of clips that are 
slowed down. There are two ways you can set this. First, there’s a project-wide setting available 
in the Master Settings of the Project Settings. Secondly, you can change how clips are retimed 
via a per-clip setting available in the Inspector.

To change the Retime Process setting of an entire project:
1 Open the Project Settings and click to open the Master Settings panel.

2 Choose an option from the Frame Interpolation group Retime Process pop-up menu.

To change an individual clip’s Retime Process setting:
Select a clip, then open the Inspector and choose an option from the Retime Process 
pop-up in the Retime and Scaling group. If you choose Optical Flow, you can also 
choose an option from the Motion Estimation pop-up.

Here are the different options you have for processing speed effects:

 � Retime Process: Lets you choose a default method of processing clips in mixed frame 
rate timelines and those with speed effects (fast forward or slow motion) applied to 
them, on a clip-by-clip basis. The default setting is “Project Settings,” so all speed 
effected clips are treated the same way. There are three options: Nearest, Frame 
Blend, and Optical Flow, which are explained in more detail in the Frame Interpolation 
section of Chapter 3, “System and User Preferences.”

 – Nearest: The most processor efficient and least sophisticated method of processing; 
frames are either dropped for fast motion, or duplicated for slow motion.

 – Frame Blend: Also processor efficient, but can produce smoother results; adjacent 
duplicated frames are dissolved together to smooth out slow or fast motion effects. 
This option can provide better results when Optical Flow displays unwanted artifacts.

 – Optical Flow: The most processor intensive but highest quality method of speed 
effect processing. Using motion estimation, new frames are generated from the 
original source frames to create slow or fast motion effects. The result can be 
exceptionally smooth when motion in a clip is linear. However, two moving elements 
crossing in different directions or unpredictable camera movement can cause 
unwanted artifacts.
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 � Motion estimation mode: When using Optical Flow to process speed change effects or 
clips with a different frame rate than that of the Timeline, the Motion Estimation pop-up 
lets you choose the best-looking rendering option for a particular clip. Each method 
has different artifacts, and the highest quality option isn’t always the best choice for a 
particular clip. The default setting is “Project Settings,” so all speed effected clips are 
treated the same way. There are several options. 

 – “Standard Faster” and “Standard Better” are the same options that have been 
available in previous versions of DaVinci Resolve. They’re more processor-efficient 
and yield good quality that are suitable for most situations. 

 – “Enhanced Faster” and “Enhanced Better” should yield superior results in nearly 
every case where the standard options exhibit artifacts, at the expense of being 
more computationally intensive, and thus slower on most systems. 

 – “Speed Warp” is available for even higher-quality slow motion effects using the 
DaVinci Neural Engine. Your results with this setting will vary according to the 
content of the clip, but in ideal circumstances this will yield higher visual quality with 
fewer artifacts than even the Enhanced Better setting. This setting is only available 
on a clip by clip basis; it’s not available in the Project Settings.

Optical Flow Quality Settings Affecting Speed Effects
The “Motion estimation mode” pop-up in the Master Settings panel of the Project Settings let 
you choose the tradeoff between quality and processing speed to use when processing optical 
flow-based slow motion and frame rate retiming effects. The “Standard Faster” and 
“Standard Better” settings are the same options that have been available in previous versions 
of DaVinci Resolve. They’re more processor-efficient and yield good quality that are suitable for 
most situations. However, “Enhanced Faster” and “Enhanced Better” should yield superior 
results in nearly every case where the standard options exhibit artifacts, at the expense of 
being more computationally intensive, and thus slower on most systems.

Chapter – 42 Speed Effects 845



Chapter 43

Subtitles and 
Closed Captioning

DaVinci Resolve 15 adds new features to support subtitles and closed 
captioning in sophisticated ways. With dedicated subtitle/closed caption 
tracks that can be shown or hidden, subtitle file import and export, 
sophisticated subtitle editing and styling at the track and clip level, and 
comprehensive export options, adding subtitles and closed captions to 
finish your project is a clear and straightforward workflow.
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Subtitles and Closed Captioning Support
Subtitles are supported in DaVinci Resolve using specially typed subtitle tracks containing 
specifically designed subtitle generators to add and edit subtitles for a program. Typically each 
subtitle track corresponds to a single language or use, and you can change the name of a 
subtitle track to reflect its contents. 

Subtitle tracks can be locked, have Auto Select controls, and can be enabled or disabled like 
any other track. Additionally, a special subtitle-only destination control lets you choose which 
subtitle track to edit subtitle clips into. Furthermore, subtitle generator clips can be resized, 
moved, edited, and overwritten like most other clips.

Subtitle track with lock, Auto Select, and enable/disable controls

Viewing Subtitle/Caption Tracks
One important difference between subtitle tracks and other kinds of tracks is that only one 
subtitle track can be visible at any given time. That means if you have multiple subtitle tracks, 
each for a different language, clicking the Enable control for one subtitle track disables 
all others.

Viewing one subtitle track at a time

Adjusting QC Thresholds For Subtitle/Caption Timing
To help you adhere to guidelines that specify the recommended duration, line length, and 
speed of captions and subtitles, the Subtitles panel of the Project Settings has parameters you 
can set to warn you when a particular subtitle clip exceeds thresholds of Characters Per Line, 
Minimum Caption Duration, and Maximum Characters Per Second.

 

The Subtitles Setup parameters in the Subtitles panel of the Project Settings
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As you edit a subtitle clip, these thresholds are used to automatically calculate how many lines 
and characters are allowable for a particular subtitle clip given its duration. For example, if you 
exceed the calculated threshold, the CPS value of that caption turns red to warn you.

 

The CPS value of a subtitle has turned red 
because it exceeds the current QC threshold

Importing Subtitles and Captions
Oftentimes, adding subtitles or closed captions to a DaVinci Resolve timeline will involve 
importing a subtitle file that’s been prepared elsewhere. Currently, DaVinci Resolve supports 
subtitle files in the .srt SubRip format. 

To import an .SRT-formatted subtitle or closed captioning file:
1 Open the Media Pool.

2 Right-click on any bin in the Bin list, or anywhere in the background of the Media 
Pool browser, and choose Import Subtitle.

3 In the resulting file dialog, find and select the subtitle file you want to import, 
and click Open.

4 The subtitle file appears as a subtitle clip in the Media Pool, ready for editing into a 
subtitle track. A badge indicates that it’s a subtitle clip.

An imported .srt subtitle file
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5 To add a subtitle clip to a timeline, do one of the following:

 – Drag a subtitle file you’ve imported into the unused gray area at the top of your 
video tracks, and a subtitle track will automatically be created for adding those 
subtitles into

 – Drag a subtitle file you’ve imported into a pre-existing subtitle track

As you drag the subtitle clip, it’ll immediately be decomposed so that each title is 
added to the Timeline as an individual subtitle clip, with its timing offset relative to the 
position of the first frame of the first subtitle in that file. 

(Top) The original Timeline, (Bottom) The Timeline after 
dragging a subtitle file has created a new subtitle track

6 Position the imported subtitles so that they align with the first frame of your program 
that they’re supposed to, and drop the titles into the track. If you inadvertently misplace 
the subtitles, don’t worry, you can always select them all and slide them earlier or later, 
just like any other clips.

7 If you’ve added a new subtitle track, you can rename it to identify what language and 
country that track corresponds to. Please note that subtitle track names are used 
when exporting or encoding subtitles, so please make sure your tracks are named 
appropriately prior to export/delivery.

8 If you want to restyle all of the subtitles you’ve just added, for example to make them 
smaller or change the font, then click on the header of the subtitle track you’ll be 
working on, open the Track Style panel of the Inspector, and select the formatting you 
want that track to use.

To see a list of every subtitle clip you’ve added, you can select the header of the subtitle track 
you’ve just added and open the Captions panel in the Inspector. A list at the bottom of the 
Captions panel gives you a convenient way of navigating the subtitles in a given track (using the 
Prev and Next buttons) and making selections. If you set the Inspector to be full height, you’ll 
have even more room for browsing the subtitle list.
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The Captions list shows you every caption or subtitle on a 
track, for selecting, editing, deleting, or navigating

Adding Subtitles and Captions Manually
Other times, you may need to create subtitles on your own. Before doing so, you’ll need to add 
one or more subtitle tracks. Once those tracks are created, you can add subtitle generators to 
them in a variety of ways. You can add as many subtitle tracks as you need, one for each 
language you require.

To add new subtitle tracks:
Right-click in any track header of the currently open timeline, and choose Add Subtitle 
Track. An empty subtitle track will appear at the top of the Timeline, named “Subtitle 1,” 
and if Subtitle Tracks were hidden, they’re now shown. Once you’ve added a new 
subtitle track, you can rename it to identify what language and country that track 
corresponds to. Please note that subtitle track names are used when exporting or 
encoding subtitles, so please make sure your tracks are named appropriately prior to 
export/delivery.

You can show and hide subtitle tracks in case you need to free up room in the Timeline for 
working on other tracks. Subtitles on the currently selected subtitle track continue to be visible, 
however, regardless of whether or not the subtitle tracks are shown.
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Showing and hiding subtitles tracks:
Open the Timeline View options, and click on the Subtitle button to toggle the visibility of 
subtitles tracks on and off.

The show/hide subtitle tracks button in the Timeline View Options

To add individual subtitles to a subtitle track:
1 If you want to adjust the default style of a particular subtitle track before you start 

adding subtitles, then click on the header of the subtitle track you’ll be working on, 
open the Track Style panel of the Inspector, and select the formatting you want that 
track to use.

2 If you have multiple subtitle tracks, click the destination control of the subtitle track you 
want to add titles to. They’re labeled ST1, ST2, ST3, etc.

3 Move the playhead to the frame where you want the new subtitle to begin.

Positioning the playhead where you want a new subtitle to begin

4 To add a new subtitle clip, do one of the following:

 – Open the Inspector and click Create Caption in the Captions panel of the Inspector. 
If there’s already one or more captions in that subtitle track, click the Add New 
button above the caption list, instead.

 – Right-click anywhere on the subtitle track and choose Add Subtitle to add a subtitle 
clip starting at the position of the playhead

 – Open the Effects Library, click the Titles category, and drag a Subtitle generator to 
the Subtitle track you want it to appear on.

Manually adding a subtitle
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5 If necessary, you can now edit the clip to better fit the dialog that’s being spoken or the 
sound that’s being described, by dragging the clip to the left or right, or dragging the 
beginning or end of the clip to resize it.

6 While the new subtitle clip you’ve created is selected, use the Captions panel in the 
Inspector to type the text for that particular subtitle. The text appears on the subtitle 
clip as you type it.

Editing the text of the subtitle we just created

Every time you add a subtitle, an entry is added to the subtitle list at the bottom of the Captions 
panel in the Inspector. This list gives you another convenient way of navigating the subtitles in a 
given track (using the Prev and Next buttons) and making selections.

Editing Subtitles and Captions
Subtitle clips can be selected singly or together, and slipped, slid, resized, rolled, and rippled 
just like any other clip in the Timeline, using the mouse or using keyboard commands, with 
either the Selection, Trim, or Razor tools. You can select subtitle clips in their entirety, or just 
their edit points, in preparation for nudging or dynamic trimming. In short, subtitle clips can be 
edited, in most ways, just like any other clips.

Styling Subtitles and Captions
When it comes to styling subtitle text, there are a wealth of styling controls in the Track Style 
panel of the Inspector.

To modify the styling of all titles on a particular subtitle track:
1 Click on the header of the subtitle track you’ll be working on, or select a clip on a 

particular subtitle track either in the subtitle track or in the subtitle list of the Captions 
panel in the Inspector.

2 Open the Inspector, and then open the Track Style panel that appears within.

3 Edit whatever parameters you need to set the default style of all subtitles and closed 
captions that appear on that track. The Track Style panel has many more options than 
the Captions panel, including a group of Style and Position controls over Font and 
Font Face, Color, Size, Line Spacing, and Kerning, Alignment, Position X and Y, Zoom X 
and Y, Opacity, and Text Anchoring.
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The Track Style panel of the Inspector sets 
styling for every subtitle on that track

Keep in mind that there are additional groups of controls that let you add a Drop 
Shadow, Stroke, and/or Background to all text on that track, which can be found at the 
bottom of the Track Style panel of the Inspector.

Linking Subtitles to Clips
If you like, you can link one or more subtitles to their accompanying clip, so that if you re-edit 
a subtitled scene, each clip’s subtitles move along with the clips. This arrangement doesn’t 
always work the way you’d expect when trimming, but it works great when you’re 
rearranging clips.

To link a subtitle to another clip:
1 Select a clip and its subtitles all at once.

Selecting a video clip and its 
accompanying subtitle to link them

2 Choose Clip > Linked Clips (Option-Command-L). A Link icon appears to show that the 
subtitle clips are linked to the video/audio clip.
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The now linked clip and subtitle have link 
badges to show their state

Naming Subtitle Tracks
If necessary, you can double-click the name of any subtitle track to rename it to something 
more descriptive of what that subtitle track will contain, such as the language, and whether 
a particular track is for subtitles or closed captions.

Depending on your workflow and delivery specifications, there are existing conventions for 
identifying languages, such as ISO-639-1 (governing 2-letter codes) or ISO-639-2/B 
(governing 3-letter codes). These codes can be found at the International Organization for 
Standardization website, at http://www.loc.gov/standards/iso639-2/php/code_list.php. 

Some naming conventions require both language code and country code.  
For example, Facebook requires SubRip (.srt) files with the naming format “VideoFilename.
[language code]_[country code].srt” for proper embedding.

If you want to use these codes for subtitle track identification and output, here’s a 
representative list of standardized language and country codes from around the world, in 
alphabetical order:

Language
ISO 639-1  
Language Code

ISO 639-2  
Language Code

ISO 3166-1  
Country Code

Amharic am amh ET (Ethiopia)

Arabic ar ara

EG (Egypt)

AE (United Arab Emirates)

LB (Lebanon)

Bengali bn ben IN (India)

Chinese zh
chi (B)

zho (T

CN (China)

HK (Hong Kong)

TW (Taiwan)

Danish da dan DK (Denmark)

Dutch nl
dut (B)

nld (T)
NL (Netherlands)

English en eng

GB (UK)

IN (India)

US (US)
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Language
ISO 639-1  
Language Code

ISO 639-2  
Language Code

ISO 3166-1  
Country Code

Finnish fi fin FI (Finland)

French fr
fre (B)

fra (T)

CA (Canada)

FR (France)

German de
ger (B)

deu (T)
DE (Germany)

Greek Modern el
gre (B)

ell (T)
GR (Greece)

Hausa ha hau
NG (Nigeria)

TD (Chad)

Hebrew he heb IL (Israel)

Hindi hi hin IN (India)

Indonesian id ind ID (Indonesia)

Italian it ita IT (Italy)

Japanese ja jpn JP (Japan)

Malay ms
may (B)

msa (T)
MY (Malaysia)

Maori mi
mao (B)

mri (T)
NZ (New Zealand)

Norwegian no nor NO (Norway)

Polish pl pol PL (Poland)

Portuguese pt por
BR (Brazil)

PT (Portugal)

Punjabi pa pan IN (India)

Russian ru rus RU (Russia)

Spanish Castilian es spa

CO (Columbia)

ES (Spain)

MX (Mexico)

Swahili sw swa KE (Kenya)

Swedish sv swe SE (Sweden)

Tagalog tl tgl PH (Philippines)

Thai th tha TH (Thailand)

Turkish tr tur TR (Turkey)

Urdu ur urd PK (Pakistan)

Vietnamese vi vie VN (Vietnam)
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Exporting Subtitles and Closed Captions
Once you’ve created one or more subtitle tracks filled with subtitles or captions, there are a few 
different ways you can export subtitles once you’ve created them.

Exporting Subtitles Via the File Menu
Choose File > Export Subtitle, and use the export dialog to choose a location and file type for 
the exported subtitle file. You can export subtitles in the .srt and .webvtt formats.

Exporting Subtitles Via the Subtitle Track Header
Right-click on the track header of a subtitle track, and choose Export Subtitle from the 
contextual menu. Use the export dialog to choose a location and file type for the exported 
subtitle file. You can export subtitles in the .srt and .webvtt formats.

Exporting, Burning, or Embedding Subtitles During Delivery
When you’ve set up one or more subtitle tracks in a program, the Deliver page exposes a group 
of Subtitle Settings at the bottom of the Video panel of the Render Settings that control if and 
how subtitles or closed captions are output along with that timeline.

Available options for exporting subtitles can be found at 
the bottom of the Video panel of the Render Settings

This panel has the following controls:
 � Export Subtitle checkbox: Lets you enable or disable subtitle/closed caption output.

 � Format pop-up: Provides four options for outputting subtitles/closed captions.

 – As a separate file: Outputs each subtitle track you select as a separate file using 
the format specified by the Export As pop-up. A set of checkboxes lets you choose 
which subtitle tracks you want to output.

 – Burn into video: Renders all video with the currently selected subtitle track burned 
into the video.

 – As embedded captions: Outputs the currently selected subtitle track as an 
embedded metadata layer within supported media formats. There is currently 
support for CEA-608 closed captions within MXF OP1A and QuickTime files. You can 
choose the subtitle format from the Codec pop-up that appears.
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 � Export As: (only available when Format is set to “As a separate file”) Lets you choose 
the subtitle/closed captioning format to output to. Options include SRT and WebVTT.

 � Include the following subtitle tracks in the export: (only available when Format is set 
to “As a separate file”) A series of checkboxes lets you turn on which subtitle tracks to 
output.

 � Codec: (only available when Format is set to “As embedded captions”) Lets you choose 
how to format embedded closed captions; choices include Text and CEA-608.

NOTE: Neither analog (Line 21) nor digital (CEA-708) closed caption output via 
Decklink or UltraStudio is supported at this time.
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Chapter 44

Keyframing 
Effects in the 
Edit Page

The Edit page also provides controls for keyframing effects that you add 
to your timeline, as well as a curve editor to fine-tuning the motion effects 
you create right in the Editing Timeline.
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Keyframing Effects in the Edit Page
Most parameters in the Inspector of the Edit page can be keyframed, in order to create 
animated effects such as zooming in via the Zoom parameter, fading out via the Opacity 
parameter, or cropping from one side to reveal a clip underneath via the Cropping parameters. 
Additionally, if you import a project from an NLE that has keyframed sizing settings, those 
keyframes will be imported and exposed within the Edit page of DaVinci Resolve.

The primary controls for keyframing are within the Inspector. Any parameter that can be 
keyframed has a gray keyframe button to the right of its slider. If the playhead is on a keyframe, 
this button turns orange and small  navigation arrows appear to its right and left, otherwise it 
stays gray.

Orange buttons in the Inspector show keyframe usage. Zoom shows the playhead parked on the current 
keyframe with additional keyframes set before and after this one as indicated by the gray navigation arrows. 
Position shows the playhead parked on the only keyframe set (orange diamond, no arrows), and Rotation Angle 
shows no keyframe set (gray diamond).

Once you’ve keyframed one or more parameters within a particular group in the Inspector, that 
clip displays a pair of small buttons at the far right of its name bar in the Timeline, a Curve 
button and a Keyframe button. Only keyframed clips have these buttons.

The Keyframe track button in the Timeline 
appearing on a keyframed clip

To expose a clip’s keyframe tracks, do one of the following:
 � Click the Keyframe button for that clip, at the bottom right corner of the clip. 

 � Choose Clip > Show Keyframe Editor (Shift-Command-C)

Each group of parameters in the Inspector reveals a single, aggregated keyframe track, that 
holds all the keyframes of all the parameters within that group, and makes it easy to move, 
delete, cut, copy, and paste keyframes for each clip. For example, the Pan, Tilt, Zoom, Rotation 
Angle, and Anchor Point keyframes all appear within the Transform track.
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A keyframe track for all of the Transform group parameters

If you want to edit each parameter independently, a small disclosure control at the right of each 
keyframe track lets you open up an aggregated keyframe track into individual keyframe tracks, 
one for each parameter that’s been keyframed within that group of Inspector controls.

Clicking a keyframe track’s disclosure control reveals individual 
keyframe tracks for each keyframed parameter in the Inspector

Additionally, each keyframed clip has a Curve button that, when clicked, exposes that 
parameter within a Curve Editor that’s attached to the clip in the Timeline. 

A clip’s Curve button, used to open the Curve Editor 
for that particular clip

To expose a clip’s Curve Editor:
 � Click a clip’s Curve button, at the bottom right corner of the clip.

 � Choose Clip > Show Curve Editor (Shift-C).

Multiple parameters can be opened within the Curve Editor at the same time, and you can 
choose which curve to work on by clicking it in the Curve Editor, or clicking one of that 
parameter’s keyframes in the keyframe track above. Selected control points can be moved, and 
their Bezier interpolation changed using one of the four buttons located at the top of the 
Curve Editor.
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Keyframing in the Inspector
Keyframing in the Edit page works slightly differently than when using the Keyframe Editor in 
the Color page. Most simple keyframing tasks can be performed in the Inspector using three 
buttons that appear to the right of any parameter that’s capable of being keyframed. It takes 
two keyframes at minimum to create an animated effect.

The three keyframe controls that appear in the 
Inspector, from left to right: Previous keyframe, 
Create/Delete keyframe, Next keyframe

Methods of keyframing parameters in the Inspector:
 � To add a keyframe: Select a clip, open the Inspector, then move the Timeline playhead 

to the frame where you want to place a keyframe, and click the Keyframe button next 
to the parameter of the Inspector you want to animate. Once you’ve added at least 
one keyframe to a parameter, all other adjustments you make to parameters in the 
Inspector, or using the onscreen Transform/Crop controls in the Timeline Viewer add 
new keyframes automatically if the playhead is at another frame.

 � To move the playhead to the next or previous keyframe: Click the small left- or right-
hand arrow to either side of a parameter’s keyframe control to jump the playhead to the 
next or previous keyframe. You can also press Right-Bracket ( [ ) and Left-Bracket ( ] ) to 
go from keyframe to keyframe.

 � To edit an existing keyframe of a parameter: Move the playhead to be on top of the 
keyframe you want to edit, and then change that parameter, either in the Inspector, or 
using the onscreen controls of the Timeline Viewer.

Methods of changing keyframe interpolation in the Inspector:
 � To change a keyframe to Ease In or Ease Out: Eased keyframes create animated 

changes that begin slowly and accelerate to full speed, or slow down gradually to 
decelerate to a stop. This only works when you have two or more keyframes creating 
an animated effect. Move the playhead to a frame with a keyframe using the next/
previous keyframe controls, then right-click the orange keyframe button and choose 
Ease In, Ease Out, or Ease In and Out, depending on which keyframe you’re editing and 
the effect you want to create.

 � To change a keyframe to Linear: Move the playhead to a frame with a keyframe using 
the next/previous keyframe controls, then right-click the orange keyframe button and 
choose Linear.

Methods of deleting keyframes and disabling keyframed effects:
 � To delete a single keyframe: Open the Inspector, move the Timeline playhead to a frame 

with a keyframe, and click the orange Keyframe button in the Inspector to delete it.

 � To delete all keyframes for one parameter: Click the reset button to the right of a 
parameter’s keyframe control in the Inspector.

 � To delete all keyframes in a group of parameters in the Inspector: Click the reset 
button to the right of a parameter group’s title bar in the Inspector.
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 � To disable or enable a single parameter’s keyframed effect: In the Timeline, click 
the toggle control at the left of a parameter’s keyframe track. White means that track’s 
enabled. Gray is disabled.

 � To disable or enable a group of parameters in the Inspector: Click the toggle control 
at the left of a parameter group’s title bar in the Inspector. Orange means that group is 
enabled. Gray is disabled.

Keyframing Motion Paths in 
the Timeline Viewer
If you’re keyframing a clip’s transform controls to create motion, a motion path appears when 
you turn on the onscreen transform controls using the button to the left of the 
transport controls.

A visible motion path resulting from animated Position X and Y parameters

Each keyframed change to the Position X and Y parameters creates a control point on the 
surface of the motion path, which is linear by default, creating a sharp edge. However, you can 
right-click any control point and choose Smooth from the contextual menu to add Bezier 
handles to that control point, which let you change the sharp angle to an adjustable curve.

Changing the linear control point into a Bezier curve

The control points making up any motion path can be dragged around at will to change the 
path the selected clip will travel. Dots on the surface of the motion path indicate the velocity of 
motion; dots that are closer together indicate slower motion, while dots that are farther apart 
indicate faster motion. Dragging a motion path control point farther away from another one will 
speed up the animation between both points, while dragging it closer will slow the animation 
down, as you’re setting up the selected clip to travel a longer or shorter distance within the 
same keyframed time.
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Dots on the motion path show that the left half has slow 
motion, while the right half has faster motion

You can also adjust the shape of any control point’s curve by clicking to select that control 
point, which exposes its Bezier handles, and then dragging the handles to adjust its curve. 
Once handles have been exposed, there are a variety of methods you can use to adjust them 
and manipulate the motion path.

Finally, you can adjust the acceleration of motion by adjusting the Acceleration handle on the 
stem of any Bezier curve. Dragging an acceleration handle towards a control point creates an 
eased keyframe, where motion slows to a stop, or begins from a stop. Dragging an acceleration 
handle away from a control point creates more linear motion, where the object moves 
continuously through that control point.

An acceleration handle on the Bezier handle of a 
curve lets you create eased motion by dragging 
it in towards the control point being adjusted
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Methods of adjusting the Bezier handles of motion paths:
 � Drag any control point to reshape the motion path.

 � Drag any Bezier handle to change the shape of the curve.

 � Command-drag any Bezier handle to break the tangent between it and the opposite 
Bezier handle. When you release the Command key, the two Bezier handles become 
locked together again at whatever angle you created.

To eliminate a control point on a motion path, along with its keyframe:
Right-click any control point and choose Delete Keyframe.

To switch a control point between sharp and curved angles:
Right-click any control point and choose Linear (for a sharp angle) or 
Smooth (for a curve).

Keyframing in the Timeline 
and Curve Editor
If you need to do more complicated keyframe editing than the relatively simple controls of the 
Inspector allow, you can use the Keyframe tracks and Curve Editor found in the Timeline. When 
one or more clip parameters are keyframed, two small buttons appear at the far right of a clip’s 
name bar in the Timeline, a Curve button and a Keyframe button. These buttons let you access 
specialized keyframe editors that serve different purposes.

The Keyframe Editor
The Keyframe Editor in the Timeline is the simplest way of exposing all of a clip’s keyframes and 
adjusting their timing and interpolation. It’s only available when you’ve already keyframed one 
of a clip’s Inspector properties. 

To open or close the Keyframe Editor:
 � Click a clip’s Keyframe button at the far right of a clip’s name bar.

 � Select a clip and choose Clip > Show Keyframe Editor (Command-Shift-C).

The Keyframe track button in the Timeline 
appearing on a keyframed clip

The Keyframe Editor exposes one keyframe track for each group of parameters that’s 
keyframed. For example, the Composite parameters, Transform parameters, and 
Cropping parameters are all encapsulated by group tracks. For example, if you’d added 
keyframes to the Zoom and Position parameters, these keyframes all appear within a 
single keyframe track labeled Transform, while Opacity adjustments appear on a 
second keyframe track for Composite.
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Group keyframe tracks open in the Timeline

However, each group keyframe track has a disclosure button that lets you show or hide 
each individual parameter that’s keyframed within that group. For example, clicking the 
Transform keyframe track’s disclosure button shows the Zoom and Position tracks, so 
you can adjust those individual keyframes.

Individual parameter keyframe tracks open in the Timeline

These keyframe tracks let you edit keyframes in context of the actual clip durations in 
the Timeline. Click the small Keyframe button at the bottom right of the clip’s name bar 
to close the keyframe tracks when you’re finished.

Methods of adding and selecting keyframes in the Keyframe Editor of the Edit page:
 � To add new keyframes to the Keyframe Editor: Option-click anywhere on a track of 

the Keyframe Editor to add a new keyframe, which defaults to whatever the current 
value is for that parameter at that frame. New keyframes create linear animated 
changes by default.

 � To duplicate one or more keyframes: Make a selection of keyframes, then hold the 
Option key down and drag the selected keyframes to duplicate them and move the 
duplicates to a new position.

 � To select a single keyframe: Click a single keyframe to select it.

 � To select multiple discontiguous keyframes: Command-click all keyframes you want to 
select, whether they’re next to one another or not.

 � To select multiple contiguous keyframes: Click the first keyframe you want to select, 
and then shift-click the last keyframe you want to select, and all keyframes between 
will also be selected, or drag a bounding box within the keyframe track around multiple 
keyframes to select them all at once.

Chapter – 44 Keyframing Effects in the Edit Page 867



Methods of changing keyframe interpolation/easing/smoothing in the 
Keyframe Editor of the Edit page:

 � To change one or more Linear keyframe to Ease In or Ease Out: Eased keyframes 
create animated changes that begin slowly and accelerate to full speed, or slow 
down gradually to decelerate to a stop. This only works when you have two or more 
keyframes creating an animated effect. Select one or more keyframes, then right-click 
one of the selected keyframes and choose Ease In, Ease Out, or Ease In and Out, 
depending on which keyframe you’re editing and the effect you want to create.

 � To change one or more eased keyframes to Linear: Select one or more keyframes, 
then right-click one of the selected keyframes and choose Linear.

Methods of moving and adjusting keyframes in the Keyframe Editor of the Edit page:
 � To move one or more keyframes: Select one or more keyframes and drag left or right. 

While you drag keyframes, a tooltip appears showing you the offset in frames of your 
adjustment from the beginning of that clip’s source media. If you’re only dragging one 
keyframe, the tooltip also shows you the name of the parameter you’re modifying.

 � To nudge selected keyframes one frame at a time: Select one or more keyframes and 
press Command-Left Arrow or Command-Right Arrow to nudge them back and forth, 
for precision editing. The Curve Editor must also be open.

Methods of Cutting, Copying, Pasting, and Deleting keyframes:
 � To cut or copy, and paste one or more keyframes: Make a selection of keyframes, 

and use the Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the 
playhead to where you want the first of the copied keyframes to start, and press Paste 
(Command-V). The Curve Editor must also be open.

 � To delete one or more control points from a curve: Select the keyframe(s) you want to 
delete and press Backspace. The Curve Editor must also be open.

The Curve Editor
If you want to work with keyframes in even more detail, you can use the Curve Editor. The 
Curve Editor can be opened in addition to the Keyframe Editor, or it can be opened in isolation. 
When clicked, the Timeline expands to accommodate a large space under an animated clip in 
which you can freely adjust both the timing and value of selected keyframes, while also 
providing optional bezier spline controls used to create smooth curves with which to adjust the 
acceleration of animated changes from one value to another.

To open or close the Curve Editor:
 � Click a clip’s Curve button at the far right of a clip’s name bar.

 � Select a clip and choose Clip > Show Curve Editor (Shift-C).

The Curve Editor open in the Timeline
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You can open multiple parameters into the Curve Editor using the curve pop-up menu at the 
upper left-hand corner of the Curve Editor that lets you choose which parameters are exposed 
via checkboxes. This menu also lets you choose which curve is selected by clicking the name 
of the parameter you want to edit.

Choosing which parameters to 
display in the Curve Editor

While you can only work on one curve at a time, you can choose which is selected for editing 
by either selecting it in this pop-up menu or by clicking any dimmed curve in the Curve Editor. 
Using the control points exposed by each curve, you can edit parameters, alter keyframe 
timing, and change each control point’s interpolation to create custom easing effects affecting 
the acceleration of change from one keyframe to the next.

Methods of adding and selecting keyframes in the Curve Editor of the Edit page:
 � To change which curve you’re editing: If the Keyframe Editor is open at the same 

time as the Curve Editor, you can click the keyframe track you want to edit and the 
corresponding curve will be highlighted. Otherwise, click the Curve menu at the upper 
left-hand corner of the Curve Editor, and choose which curves you want to expose to 
work on. If multiple curves are open in the Curve Editor, click any dimmed curve in the 
background to highlight it for editing. If the clip you’re editing is too narrow, then the 
Curve menu may be hidden; zooming into the Timeline will show the Curve menu again.

 � To add new keyframes to a curve: Option-click anywhere on a curve to add a new 
control point.
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 � To duplicate one or more keyframes: Make a selection of keyframes, then hold the 
Option key down and drag the selected keyframes to duplicate them and move the 
duplicates to a new position (and even new values). This can be a good way to quickly 
loop a repetitive animated effect you’ve created.

 � To select a single keyframe: Click a single keyframe to select it.

 � To select multiple discontiguous keyframes: Command-click all keyframes you want to 
select, whether they’re next to one another or not.

 � To select multiple contiguous keyframes: Click the first keyframe you want to select, 
and then shift-click the last keyframe you want to select, and all keyframes between 
will also be selected, or drag a bounding box within the Curve Editor around multiple 
keyframes to select them all at once.

 � To select all keyframes: If the Keyframe Editor is open and it has focus (by clicking 
anywhere within it), then pressing Command-A will select all keyframes within that 
Keyframe Editor.

Methods of adjusting keyframes in the Curve Editor of the Edit page:
 � To drag one or more keyframes freely on a curve: Select one or more keyframes and 

drag left or right to retime them, and up or down to change their value.

 � To drag one or more keyframes on a curve in only one direction: Select one or more 
keyframes, then hold the Shift key while dragging either vertically or horizontally to 
constrain keyframe adjustment within that single direction.

 � To nudge selected keyframes one value or frame at a time: Select one or more 
keyframes and Command-Left Arrow and Command-Right Arrow to nudge them in 
time, or Command-Up Arrow and Command-Down Arrow to nudge their value, for 
precision keyframe adjustments.

Methods of changing keyframe interpolation/easing/smoothing:
 � To change the interpolation of a single keyframe: There are two methods. You 

can select the keyframes you want to change, and then click one of the four Bezier 
interpolation buttons in the Curve Editor title bar. Or, you can right-click one of the 
selected keyframes and choose one of the interpolation options from the contextual 
menu. Keyframes that have already been eased in the Keyframe Editor or via controls in 
the Inspector already have bezier handles exposed in the Curve Editor.

 � To change the interpolation of multiple keyframes: Select multiple keyframes by 
Command-clicking or dragging a bounding box, and then click one of the four Bezier 
interpolation buttons in the Curve Editor title bar to simultaneously change the 
interpolation of all of them.

 � To adjust a Bezier handle: Drag the Bezier handle in any direction to alter the curve.

The Curve Editor with Bezier interpolated keyframes
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Methods of Cutting, Copying, Pasting, and Deleting keyframes:
 � To cut or copy, and paste one or more keyframes: Make a selection of keyframes 

and use the Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the 
playhead to where you want the first of the copied keyframes to start, and press Paste 
(Command-V).

 � To delete one or more control points from a curve: Select the keyframe(s) you want to 
delete and press Backspace.

Keyframable OpenFX and ResolveFX
The parameters of OpenFX and ResolveFX have keyframe controls to the right of each 
parameter’s number field in the Inspector of the Edit and Color pages, so you can animate 
effects that you add to clips and grades.

ResolveFX can now be animated in the Edit page 
using keyframe controls in the Inspector

Additionally, keyframes added to ResolveFX parameters in the Inspector now appear in both 
the Keyframe and Curve Editor of the Edit page Timeline. You can expose individual keyframe 
tracks and curves for each keyframed parameter of an effect applied to a clip, for smoothing, 
retiming, or editing.

ResolveFX keyframes exposed in the Edit page Curve Editor
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Chapter 45

VFX Connect

For instances where the various effects of the Edit, Fusion, and 
Color page aren’t enough to achieve the effect you require, you can use 
the VFX Connect feature of DaVinci Resolve to send one or more clips 
from the Edit page timeline to the standalone version of Blackmagic 
Fusion, in order to do more robust compositing and effects work there. 
You can use this workflow in the macOS, Windows, and Linux versions of 
DaVinci Resolve, since Fusion works on all three platforms. This is a simple 
round-trip operation that lets you send clips from the DaVinci Resolve 
Timeline to Fusion, add effects, and then render a finished effect out of 
Fusion that will automatically appear back in your timeline.
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Using VFX Connect
Sending one or more clips to the standalone version of Blackmagic Fusion is simple.

To send clips to Fusion:
1 Select one or more clips in the Timeline that you want to send to Fusion. In this 

example, two superimposed clips are selected.

Selecting two clips to send to Fusion

2 Right-click one of the selected clips and choose New VFX Connect Clip from the 
contextual menu.

3 In the New VFX Connect Clip dialog, choose the following options:

a Enter a name.

b Choose a video format (for rendering media to send to Fusion).

c Choose a codec, based on the format you selected.

d If you want to send Alpha channels to Fusion, turn the Export Alpha checkbox on. 
This exports alpha channels that are embedded in a clip, as well as alpha channels 
that are being created in DaVinci Resolve.

e If you want to save the VFX Connect Clip that you’re creating, along with its 
directory and media, to a specific location, turn on the Custom Location checkbox, 
then click the Browse button and choose a location. Otherwise, the directory 
containing the VFX Connect clip and any source media rendered along with it is 
placed in the same directory as the scratch disk.

f If you want to immediately open Fusion, turn on the “Open VFX Connect Clip” 
checkbox. If you do this, then DaVinci Resolve by default renders each of the video 
clips you selected, along with every speed effect, transform, and Color page 
operation that’s been applied to each clip, using the Timeline Color Space. 
However, if you click Cancel when the Render Composition Media dialog appears, 
then the Fusion project that opens references the source media on disk, rather than 
rendered media that’s generated by DaVinci Resolve.

The New VFX Connect Clip dialog
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4 When you’re finished, click Create. DaVinci Resolve creates a VFX Connect clip, which 
appears in the Timeline as a single clip and in the Media Pool.   

(Left) VFX Connect clips in the Timeline, (Right) in the Media Pool

5 Opening the VFX Connect clip in Fusion can be done in one of two ways:

 – If you turned on “Open VFX Connect Clip,” then Fusion automatically opens and the 
clips you selected appear as Loader nodes within Fusion.

 – If you didn’t, then you can right-click the VFX Connect clip in the Media Pool, and 
choose VFX Connect > Open Fusion from the contextual menu.

At this point, new media is rendered (by default), Fusion opens, and the clips you sent 
are converted into a Fusion node tree, explained in greater detail in the 
following section.

6 In Fusion, use the available tools to create the required effect.

7 Optionally, before you render, if you want to change the Output Format, click the 
Output node, and choose a new format from the Output Format pop-up in the Tools 
tab. If you don’t do this, the Fusion composite will be rendered using the format you 
selected when you sent the VFX Connect clip in the first place.

The Tools panel where you can change the file 
information governing the rendered output

8 When you’re finished creating your effect in Fusion, click the Render button to open 
the Render Settings, check to make sure that the settings are correct, and click Start 
Render. This renders the Fusion composition to the disk location and using the name 
that you chose in step 3. 

Selecting two clips to send to Fusion
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9 A Render Settings dialog appears, which lets you choose how you want to render the 
output, with options including the Quality, Frame Range, and Size of the media being 
output. If the default settings are good, click Start Render. A progress bar indicates how 
long the render will take. For more information, consult the Fusion User Manual.

10  Once rendering has finished, save your Fusion project, reopen DaVinci Resolve, and 
you should see that the VFX Connect clip in the Timeline has updated to show the new 
effect you created in Fusion.

How Clips are translated 
into Node Trees
In Fusion, each clip that you send appears as a Loader node that is linked to that clip’s media on 
disk. If you selected multiple clips, each clip is superimposed over the one just below it using a 
Merge node, which lets you merge two images at a time with an Over operator by default.

Two superimposed clips sent to Fusion as represented in the Fusion node tree

With this as your starting point, you can add nodes (called Tools in Fusion) to apply operations 
of your own, in order to create more sophisticated effects and composites. For more information 
about using Fusion, see the Fusion User Manual, available from the Support page at the 
Blackmagic Design web site.

Altering VFX Connect Clips
If, at any point, you want to modify the Fusion composition, you can reopen the project in 
Fusion, or right-click the VFX Connect clip in the DaVinci Resolve Media Pool and choose VFX 
Connect > Open in Fusion. Once in Fusion, make whatever changes you want to, and then 
re-render the clip to overwrite the previously rendered media. When you create new versions in 
this way, each version’s Fusion project file and rendered output is maintained and preserved, 
so you can always go back and forth.

When you return to DaVinci Resolve, you may need to right-click the VFX Connect clip you just 
opened, and choose VFX Connect > Refresh to make sure that DaVinci Resolve correctly sees 
the re-rendered media from Fusion.
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Creating Multiple Versions of Fusion Clips
If you want to render a new version, but you want to keep the previous version, then you can 
right-click the VFX Connect clip in the Resolve Media Pool and choose VFX Connect > Create 
New Version. 

Creating a new version of a VFX Connect composite

This creates a duplicate of the composite in Fusion, with the “_v1” part of the filename 
incremented so it doesn’t overwrite the previous version of that composite. 

Once in Fusion, make whatever changes you need to the composite, then re-render the clip to 
generate an additional piece of media for that version. The filename of the Saver node for the 
new media you’re rendering is also automatically incremented with the “_v1” segment of the 
filename changed to the next version number, such as “_v2” if it’s version two of the effect.

The Tools panel shows the Saver node’s updated 
filename for the new version’s rendered output

When you’re finished, you’ll end up with a Fusion Project file and a corresponding rendered 
media file that share the same version number. When you return to DaVinci Resolve, Resolve 
will automatically detect that there are multiple versions in the VFX Connect directory, and will 
make each version available via a Choose Version submenu for VFX Connect clips in the 
Media Pool.
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Switching Versions of VFX Connect Clips in DaVinci Resolve
Once you’ve created multiple versions of a VFX Connect clip, you can switch which version is 
used for that clip in DaVinci Resolve by right-clicking the VFX Connect clip in the Media Pool, 
and choosing the version from the VFX Connect > Select Version submenu of the 
contextual menu.

Choosing which version to use from the VFX Connect > Select Version submenu

TIP: If you want to switch versions for a VFX Connect clip in a timeline, you can 
right-click that clip and choose Find in Media Pool.

Sending a VFX Connect Directory 
to Another Machine
If you’re going to hand off a VFX Connect directory to someone else using a different 
workstation, it’s a good idea to render self-contained media for the Fusion composition to make 
it easy to hand off everything the compositing artist will need. Otherwise, you’ll need to 
manually find and provide the associated media files yourself. There are two ways of rendering 
self-contained media for Fusion:

 � If you check “Open VFX Connect Clip” in the New VFX Connect Clip dialog, then 
DaVinci Resolve by default renders each of the video clips you selected, along with 
every speed effect, transform, and Color page operation that’s been applied to each 
clip, using the Timeline Color Space. 

 � If you haven’t opened the VFX Connect clip in Fusion yet, you can also right-click any 
VFX Connect clip in the Media Pool, and choose VFX Connect > Render Media from 
the contextual menu.

Once that’s done, there are two ways you can locate the actual VFX Connect directory’s 
location, in order to copy it for whomever is going to be doing the compositing work for you.

 � You can turn on the Custom Location checkbox in the New VFX Connect Clip dialog, 
then click the Browse button and choose a location where the resulting directory is 
easily copied.

 � You can also right-click on any VFX Connect clip in the Media Pool, and choose Reveal 
in Finder to open that VFX Connect clip’s directory.
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Since your DaVinci Resolve project keeps track of the location of the VFX Connect directory 
from the moment it’s created, you don’t want to move it, since DaVinci Resolve is counting on it 
being where it thinks it is. Once your colleague has completed the compositing work in Fusion, 
all they need to do is send you back the Fusion Composition file ( just so you can keep 
everything together), and the media they rendered, both of which you need only copy to the 
top level of the corresponding VFX Connect directory. Once you do that, DaVinci Resolve 
should automatically see the rendered media and refresh those VFX Connect clips on 
your timeline.

Creating Multiple Versions of Fusion Clips 
on Another Machine
If you’ve handed off the directory created by the VFX Connect process to someone off site, 
they can still create multiple versions of the composite that can be managed by 
DaVinci Resolve.

Use the Save As command in Fusion to save a duplicate of the Fusion project with the “_v1” 
segment of the filename incremented to the next version number, such as “_v2” if it’s version 
two of the composite. Make sure you save this duplicate Fusion project into the same directory 
as the original, so DaVinci Resolve can find it. Once created, you can change this duplicate 
project file any way you need.

When you’re finished, select the Saver node (at the very end of the Fusion node tree), and 
change the filename by incrementing the V1 part of the Filename field. For example, if your clip 
is being named Output_V1.mov, then change the filename to Output_V2.mov in the Tools tab, 
and render. If you’re rendering a DPX image sequence, then you’ll want to change the name of 
the folder that encloses the frames, so change the filename from “.../fusion/OutputDirectory_V1/
Output_00000000.dpx” to “.../fusion/OutputDirectory_V2/ Output_00000000.dpx” to obtain a 
correctly named second version.

Updating VFX Connect Clips Using 
Render Media and Refresh
If you change a grade or effect that’s applied to a clip inside of a VFX Connect clip, you’ll need 
to right-click that clip and choose VFX Connect > Render Media to re-render updated media 
files for the Fusion project.

If you re-render a Fusion composite and overwrite media that’s already referenced by a VFX 
Connect clip in an open DaVinci Resolve project, you may need to refresh that media reference 
in DaVinci Resolve. The easy way to do this is to right-click any VFX Connect clip in the Media 
Pool, and choose VFX Connect > Refresh.
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